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Chapter 1. General Information

1.1 Introduction

System The Pavement Historical Database (PHD) is a centralized electronic data warehouse designed

Definition to store “As Built” pavement typical section information and materials data on Michigan’s

state-owned roads (trunkline). The data can be quickly and easily searched, sorted, and
exported, without the need to review each project’s plans, proposal, contract modifications,
and other construction-related documents.

Compared to the originally planned or designed records, “As Built” information represents
existing pavement typical sections, materials, suppliers, job completion date, etc., which
reflect any changes made during construction. These changes include, among others; changes
in the road location, length, and alignment; changes in pavement cross-section and/or
quantity, and changes in materials used and/or their sources/suppliers.

PHD uses the project-specific Physical Road (PR) Number and milepoints as a linear
referencing system. With data stored in this manner, the system can be queried using a
variety of filter criteria, including specific route segments, specific materials, and suppliers.

1.2 PHD Purpose and Uses

Pavement Performance Monitoring & Data Analysis

» The Michigan Department of Transportation (MDOT) pavement performance monitoring
process includes, among other outcomes, the determination of Fix Live (anticipated
pavement life excluding maintenance) and Service Live (anticipated pavement life
including maintenance) for each programed job. The MDOT’s Pavement Analysis,
Valuation, Examination, and Tracking (PAVETrack) application monitors, analyzes, and
reports on the historical performance of MDOT pavements. All are used in the MDOT’s
Life-Cycle Cost Analysis (LCCA) process.

> PHD is the primary source of all new R&R and CPM project segments that are brought into
PAVETrack to be monitored and included in future analyses. PHD is the source for “As Built”
pavement and material information for let jobs and non-let jobs, which may or may not
match the project as it was initially designed or planned. In particular, non-let jobs (such
as some maintenance projects, Transportation Work Authorizations (TWA), Direct Forces
Work, Warranty work, and Permits) are only comprehensively tracked in PHD.

» PHD can also aid in tracking actual job completion dates, or the specific segment
completion date for multi-year projects.



Highway Performance Monitoring System (HPMS) reporting

» HPMS is the official federal government source of data on the extent, condition,
performance, use, and operating report characteristics of the nation’s highways. HPMS
report is required annually for all states for apportioning Federal-aid highway funds.

> PHD is a data source for the HPMS report for the state of Michigan. The HPMS report
includes pavement-related data such as lane and shoulder surface type, pavement cross-
section, total thickness, last overlay thickness, base type and thickness, median type and
width, year of last construction, year of last improvement, etc.

Pavement Management Process Plan (PaveMaPP)

» PaveMaPP is the source of pavement condition data for the Michigan Trunkline Highway
System and the current source of compiled/reported Remaining Service Life (RSL)
estimates. PHD is PaveMaPP’s source of pavement surface type and non-let jobs’ location,
timing, work type, and Fix Life attributes for use in RSL estimation/reporting.

Project Scoping, Estimating, Design, Maintenance, and Forensic Analysis

» PHD provides readily available data (reports and exports) to aid in the Scoping Process for
MDOT projects, including cost estimating, initial design, and past maintenance activities.

Materials and Work Type Trend Analysis

» The PHD database can be used in researching individual state routes, specific pavement
work types (reconstruction, overlays, pavement repairs, etc.), as well as performing
materials trend analysis. For example, PHD can provide lane miles of Crack Seal or Chip
Seal in certain years at a certain location (Region, TSC, or County), can track paved lane
and shoulder widths for a particular Region, TSC, or County, and can track the use of
particular asphalt binders (PG grade and source) within a Region, TSC, or route.

» In PHD, the search for material information and quantities, or any other historical records,
can be performed using various search criteria, such as by location (including Region, TSC,
County, and Route); by PR number, Control Section (CS) number, and milepoints; by
MDOT's Job Number; by layer type (including HMA Top/Leveling/Base, concrete,
pavement repair, joint repair, etc.); and by material type and source (such as including
binder PG and source, mix type and JMF#, cement type and source, aggregate type and
source, emulsion type and supplier, crack sealing product, cold milling type and texture,
etc.).

Permanent Database for the Michigan Trunkline Highway System

» Due to the State of Michigan's Data Retention & Disposal Schedules, including MDOT's
Data Retention Cycle, some construction-related data might be lost or not easily accessible
after several years. PHD is a centralized electronic data warehouse designed to
permanently store “As Built” pavement typical section information and materials data. The
data can be quickly and easily searched, sorted, and exported.



1.3 System Information

PHD The PHD application is accessed through the State of Michigan MiLogin website. After signing
Access in to MlLogin, PHD can be selected from the user’s list of MDOT subscribed applications.
MiILogin can be accessed from the following URLs:

» For MDOT Employees: https://miloginworker.michigan.gov/uisecure/selfservice

> For Consultants: https://milogintp.michigan.gov/eai/tplogin/authenticate?URL=/

Follow these steps to request access to PHD:

1) Log-in to MlLogin. If you do not have a MlLogin account (a consultant), click the ‘Create
an Account’ button at the bottom of the login screen, and follow all subsequent
instructions and steps.

2) After logging into MlLogin, select Find Services on the opening screen. On the new page:
a. In the Filter by Departments drop-down list, select Michigan Department of

Transportation.

b. Select MDOT Pavement Historical Database, and then click Request Service.

3) A PHD System Administrator will review your request. Meanwhile, to grant access, users
must receive approval per the following:

a. An E-mail from your supervisor (for MDOT users), or MDOT Region or TSC
representative (for consultant users), must be sent to the PHD System Administrator
indicating that there is a business need to gain access to PHD.

b. The E-mail should include the User Role and Assignment Location of the subscribing
PHD user. For Consultant Users, the E-mail should also include the job number the
consultant personnel will be entering.

c. Consultant access will be granted in accordance with the “MDOT Pavement Historical

|ll

Database (PHD) Consultant Request/Approval Protocol” document.

4) The PHD Administrator will review the request and confirm the request with the user
role and assignment location. After this is complete, MDOT Pavement Historical
Database will be shown in the user’s MILogin Application Portal for use. If after 24 hours,
you still do not have access to PHD, contact the PHD System Administrator.

Assignment The Assignment Location indicates the user’s TSC, Region, or Statewide jurisdiction. Creating

Location jobs, editing data, reassigning, and finalizing jobs are limited to within the Assignment
Location granted by Administrators. Users with TSC access may reassign or complete segment
data entry for those within their Region. For example, a user with granted access to the
Brighton TSC can create and enter jobs within the University Region.
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PHD data entry can be performed by MDOT employees and contracted Consultants. Users
are assigned different access levels to PHD functions based on their roles and responsibilities.
Users will be assigned one of the following user roles:

» Read Only user: can only view PHD data and reports.

> Data Entry user: authorized to create, enter, and modify jobs data in PHD. Data Entry
users can finalize PHD jobs for review by a Data Owner but cannot finalize PHD jobs for
submittal into the PHD database. Data Entry users can also view PHD data and reports.

» Data Owner user: authorized to create, enter, and modify jobs data in PHD. Data Owners
approve and finalize PHD jobs completed by Data Entry users for submittal into the PHD
database. These users can reassign PHD jobs to different Data Entry users. Data Owner
users can also view PHD data and reports.

» Administrator: has access to administrative functions in PHD. Administrators approve
and manage user access and define units, attributes, and layers available in the PHD
system.

PHD is managed by the Pavement Management Section of the Construction Field Services
Division. The following system administrators can be contacted for further information:

» Fawaz Kaseer: E-mail (kaseerf@michigan.gov) — Phone # (517) 599-1498
» Justin Schenkel: E-mail (schenkelj@michigan.gov) — Phone # (517) 242-2788

This manual consists of Seven Chapters and is intended as a comprehensive PHD User Guide.
Chapter 1 defines PHD and details its purpose and uses.

Chapter 2 discusses PHD jobs and job preparation (prior to the PHD data entry process)
Chapter 3 introduces the PHD system, including PHD interface and navigation.

Chapter 4 and Chapter 5 show the steps to create and modify jobs in PHD and enter “As Built”
data, for both Standard jobs and Simplified CPM format jobs. Data Entry and Data Owner
users are the main intended audience for these two chapters.

Chapter 6 shows the steps to review, edit and/or reassign, and finalize PHD jobs. Data Owner
users are the intended audience for this chapter.

Chapter 7 details the steps to querying the database, exporting PHD data, and generating PHD
reports.

Appendix A provides answers to common questions asked by PHD users.

Additional resources, training materials, and support documents can be obtained from the
PHD Informational website for MDOT employees (internal), and PHD Informational website

for consultants (public). Training and instructional videos designed to help those entering PHD

data are also available on the PHD Informational website.
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Chapter 2. PHD Job Organization and Preparation

2.1 PHD Job Data Organization

PHD Jobs &
Data
Hierarchy

All projects with pavement work, including paving and repair work, on MDOT trunkline that

are 0.1 mile or longer are to be entered into PHD. This includes reconstruction projects,

rehabilitation projects, Capital Preventive Maintenance (CPM) projects, and other repair work

projects. For each road segment, “As Built” information is entered into the PHD, such as lane

details, layers, binder type and source, aggregates type and aggregate sources, and work done

on shoulders and/or curbs and gutters. Projects or repair work less than 0.1 mile in total

length, can be optionally entered at the user’s discretion.

In PHD, projects are entered via their unique job number with their data entered and

organized as follows:

1) Jobs are made of Segments.

2) Segments are made of Lanes/Shoulders, Curb & Gutter, and Median.

3) Lanes/Shoulder, Curb & Gutter are made of Layers.

4) Layers are made of attributes.

Table 2-1 details PHD data hierarchy and examples of required inputs.

Table 2-1. PHD Data Hierarchy

Order Data Entry Example PHD Inputs*
of Entry Level
1 Job Details Job ID, Job Type, Work Type Code, Fix Life, Open to Traffic
Date, Segments PR and Milepoints
2 Segment Details Number of Lanes, Shoulder Sides, Curb & Gutter Sides,
Median Type and Width
3 Lanes/Shoulder, Surface Type, Lane Type and Width, Paving Year, Lane
Curb & Gutter Layers, Repair Work Type, Shoulder Total and Paved Widths,
Details Shoulder Surface Type, Shoulder Layers, Curb Type
4 Layers/Repair HMA Application Rate, Asphalt Binder PG and Source, Mix

Work Attributes

Design (JMF) Number, Aggregate Type and Source, Concrete
Thickness, Cement Content, Cement Type and Supplier,
Silane Material, Emulsion Type and Supplier, Asphalt Repair
Mastic Product, Cold Milling Depth and texture

* These are just some examples of the required inputs and not a complete list.



2.1.1 Job Details

Job Types

Job ID

Projects are defined and entered in PHD as “JobNet Job” or “Non JobNet Job”, depending on
whether it was let, or not let, through MDOT’s bid letting system. Job type affects PHD data
entry only at job creation. Otherwise, modifying data in PHD is the same for both “JobNet
Jobs” and “Non JobNet Jobs”.

JobNet Jobs

JobNet Jobs (formerly known as MAP jobs) are projects that occur on the MDOT trunkline and
have an MDOT Job Number with information stored in the MDOT Program Development
Portal (JobNet/SMART). Almost all the programmed jobs (in JobNet) are let through the
MDOT bid letting system.

At PHD job creation, Work Type Code (WTC) and Fix Life are automatically generated from
the JobNet database. Preliminary segment information (PR numbers and milepoints) is also
generated from the JobNet database. However, modifications to those segments or additional
segments may still be needed depending on the “As Built” project information.

Non JobNet Jobs

Non JobNet Jobs (formerly known as non-MAP jobs) are projects that occur on the MDOT
trunkline that do not have information stored in the JobNet database (i.e., not let through the
MDOT bid letting system). Non JobNet Jobs include work performed by/through
maintenance-funded work, Transportation Work Authorizations, Direct Forces Work,
Warranty Work, Permits, and Historic Projects.

Since Non JobNet Jobs are not stored in the JobNet database, work type code and fix life
information must be manually entered at job creation. Likewise, preliminary segment
information is not automatically generated, so all segment data requires manual entry.

CPM Jobs

Jobs that have Work Type Codes from 400 to 499 are CPM work type jobs. Data entry for
these types of jobs can be relatively time-consuming due to the CPM variety of fixes and
various locations. To streamline and reduce the data entry needs, for CPM jobs, users can
select the Simplified CPM format option at job creation. The simplified CPM format option
can be used for JobNet Jobs and Non JobNet Jobs. However, the simplified CPM format
should not be used if the project includes any HMA paving.

For JobNet Jobs, the PHD Job ID is simply the numeric portion of the Job Number from the
JobNet database (5 or 6 digit job number).

For Non JobNet Jobs, the PHD Job ID is determined by the user when the job is created. Table
2-2 defines the types of Non JobNet projects and Job ID naming convention guidelines.

If an incorrect job ID was used when creating a Non JobNet job, the user can change/rename
the Non JobNet job ID later, without losing entered data. For JobNet jobs, the user cannot
change the job ID once created. Please contact the PHD Administrator to correct the job ID.




Table 2-2. Non JobNet Jobs ID Naming Conventions

Job Type

Definition

PHD Job ID Naming Convention

Maintenance

Maintenance-funded work not let through MDOT
(not programmed in JobNet), performed by MDOT or
another agency.

Use the prefix “M” followed by the job
number.

Example: M21550

TWA

Transportation Work Authorization funded projects.
Usually for projects bid through the county/city.

Some TWA project information is available in the
MDOT’s MLAP (Maintenance Local Agency Payments)
database. The MLAP database can be accessed from
the MDOT MilLogin Application Portal.

Use the prefix “TWA” followed by the TWA
number. The MDOT Region financial analyst
can provide the number or assign a number if
unavailable in the MLAP database.

Example: TWA226101

Warranty

Work performed under the terms of a project
warranty. Some warranty project information is
available in the MDOT’s SWAD/QUADS database
[Statewide Warranty Administration Database
(SWAD) and Quality Assurance Database System].
The SWAD/QUADS database can be accessed from
the MDOT MILogin Application Portal.

Use the prefix “W” followed by the original
5 or 6 digit job number.

Example: W40542

Direct Forces
Work

Work performed by MDOT employees (maintenance
crew facility and/or a maintenance garage) or
contract county forces.

Direct Forces project information is usually tracked by
the Region (in Excel Spreadsheets).

Create a direct force work reference number
for PHD use only. Use the following
conventions: DYYYYCNrouteBMP.

1. The prefix “D”, followed by four digits
representing the year.

2. The two-digit county number.

3. The route name. Use an alphanumeric
with a hyphen as a separator; for
example, “US-31” or “US-31BR”.

4. The PR beginning milepoint (including the
decimal point).

Example: D202132M-1388.954
(There is a 20-character limit)

Historic

Projects let and constructed by MDOT prior to the
implementation of MDOT’s JobNet database and
MDOT'’s Architecture Project (MAP) database.

Use either the project number from the title
sheet of the historical plans or other available
records.

Example: 53201

Permit

Work constructed by others under permit, such as
widenings for commercial driveways or utilities work.

Use the prefix “P” followed by the last 10
digits of the permit number. The TSC permit
agent will be able to provide this information.

Example: P0003090010




Job
Segmentation

Segmentation
Rules

As previously noted, each job is made of segment(s). Segmentation is the process of dividing
the road into several segments (or subsegments), so that pavement-related data can be
entered for each segment separately. PHD uses the segment-specific PR Number and
milepoints (to the thousandth decimal) to define each segment's limits. Subsegments should
be created when the geometry of the lanes or the shoulders, or the attributes of the layers
making up the section change.

The segmentation process is very important and critical for the PHD database. When
exporting PHD data, and generating PHD reports, it isimportant to report any material-related
information, or geometry-related information, on a segment basis, not at the general project
level. For example, when using different HMA mixes (or different asphalt binders PG) in the
same project, it is important to identify what mix type (or binder type) was used in each
different segment.

There is no minimum length requirement for a segment. However, new segments or
subsegments should be created whenever the lane or shoulder attributes making up the
section change if the change is longer than 0.1 mile. This includes changes in the following:

» PR number

Lane(s) details (number of lanes, lane width, year paved, etc.)

Shoulders/curb & gutter details

Pavement cross-section (layers, layer details, or material changes (attributes))
Median information (type or major width change)

YV V VY

» Multiple years of construction

Any changes less than 0.1 mile in length can be entered as a new subsegment or can be
entered with the adjacent segment at the user’s discretion. The exception is segments
involving additional lanes less than 0.1 mile (turn lanes, for example). These should be
entered as new or subsegments and not included in adjacent segments.

Note that the first two rules (changes in PR number and changes in lane(s) details) are the
primary reasons for segmentation in PHD. When a JobNet Job is created in PHD, segment
information (PR numbers and milepoints) will be automatically generated (imported from the
JobNet database), and will consider any changes in PR number and lane(s) details. However,
if there are any other changes (as shown in the list of rules above) or the automated lane
subsegmentation is incorrect, then the user needs to create subsegments or modify existing
segments. For Non JobNet Jobs, preliminary segment information will not be generated, so
all segment data needs to be entered by the user.

(NOTE: Although segment information (PR numbers and milepoints) will be automaticam
generated in PHD for JobNet Jobs at job creation, modifications to those segments (or
additional segments) may still be needed since auto segmentation is based on the
originally planned or designed records (from JobNet database). PHD entry should always
be based on "As Built” information. For example, an asphalt mill and fill project could be
programmed to be from 0 to 2.3 milepoints, but the "As Built” information could indicate

Qshorter mill and fill length (0 to 1.9 milepoints). )




Segmentation
Example 1

Segmentation
Example 2

Figure 2-1 shows a road portion divided into three segments due to changes in PR number
(PR#1, PR#2, and PR#3). PR#1 segment is divided into two segments (@ and @) due to
changes in the cement supplier. PR#2 segment is also divided into two segments (@ and @)
due to changes in the number of lanes (3-lane vs. 2-lane segment). PR#3 segment is also
divided into two segments (@ and @) due to changes in the coarse aggregate supplier. If
segment @ is less than 0.1 mile, it can optionally be combined with the adjacent segment
(@). The segmentation due to changes in PR number and the number of lanes is automated
in PHD for JobNet jobs, at job creation. Newly created segments will be automatically
subsegmented per the number of lanes (regardless of JobNet or Non JobNet job type).

PR #1 PR #2 I PR #3
| 1
©,Q0, 6 ' @ ,0 ®
______ b—==- I___________‘I“—________I_ S I
N N S | |
} 1 (At least 0.1 mile?)
- - — I —
m e |
Cen'1eni Cement supplier #2
supplier #1 '
S— = " —
o~
Coarse Aggregate Supplier #1 Coarse Aggregate
Supplier #2

Figure 2-1. Segmentation Example 1

Figure 2-2 shows a road portion divided into two segments due to changes in PR number
(PR#1 (ramp) and PR#2). PR#1 is only one segment (@). PR#2 is divided into two segments
(@ and @) due to changes in the number of lanes (3-lane segment and 2-lane segment).

PR #2 (Mainline)

NOTE 1: Ramp segmentation
begins/ends at the 2’ gore point.

NOTE 2: Ramp lane adjacent to mainline is
part of mainline PR (PR#2 and segment @)

Figure 2-2. Segmentation Example 2




2.1.2 Segment Details

Lane &
Shoulder
Numbering

Lane
Numbering
Example
(Divided
Roadway)

As mentioned previously, each segment is made of Lanes/Shoulders, Curb & Gutter, and
Median. Like segmentation, there are certain rules for lane numbering, as follows:

» Lanes are always numbered right to left, facing toward increasing milepoints in the PR
segment (regardless of traffic direction).

> Lane 1is the right-most through lane of the PR segment.

» Increasing lane numbers 2, 3, etc., are lanes left of Lane 1.
+»» Examples: passing lane, center turn lane, or an opposing traffic lane (if it is the same

PR number, i.e., undivided roadway).

> Decreasing lane numbers 0, -1, etc. are lanes right of Lane 1.
+» Examples: ramp lane, passing flare, right turn lane.

» The begin/end taper point is the start/end of the lane.

> Typically, divided roadways have a different PR number for each bound, so they are
numbered separately.

NOTE: Although Lane numbering is automated for newly created segments and JobNet
Jobs at job creation, modifications (adding/deleting lane(s), or change lane numbering)
may still be needed.

Like lane numbering, right and left shoulders are established facing toward increasing
milepoints in the PR segment (regardless of traffic direction).

Figure 2-3 shows lane numbering (@,@,@, and@) and shoulder numbering (® and@ )
for two PR segments separated by a median (Divided Roadway). Note that Lane @ begins at
the start of the taper, and Lane @ends at the end of the taper.

of £

Lanes 1, 2 S 9 Lanes 1,2, 3
< Pl < > -
—_ | <« i
PR 2 MP INCREASING R B
0 /___@__O_n_a_m_p____§
A\ —4 ~
<« @ ® ws-Mainline € A
———————————————————————————————————— H:
< /’® ® @ WB - Mainline €= E

* Lane 1 is the right-most through lane facing)ward increasing PR

— EB - Mainline @ @ -

e EB - Mainline
= =>  On-Ramp @ PR 1 MP INCREASING >

Lanes O, 1, 2

ffic Direction

v

A

Lanes 1, 2

Lane ¢
Ends 4

Figure 2-3. Lane Numbering Example 1 (Divided Roadway)
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Lane
Numbering
Example
(Undivided
Roadway)

Median
Information

Figure 2-4 shows lane numbering (),2),®), and (4)) and shoulder numbering (® and@)
for undivided PR segments (Undivided Roadway).

PR MP INCREASING === Q

Vit
Traffic Direction

Figure 2-4. Lane Numbering Example 2 (Undivided Roadway)

In PHD, median information is required for each segment. This information includes a Median
Type and Width. Examples of Median Types (selectable options in PHD) include Undivided,
Concrete Barrier, Guardrail, Graded with ditch, N/A (i.e., Ramp), etc. Note that Median Type
“N/A (i.e., Ramp)” should only be used for one-way segments that do not have a median
(such as ramps). Two-way segments without medians should use the selection “Undivided”.

For segments with varying median
width, the median width in PHD is the
predominant median width including

inner shoulders (if any). For example, = -

see Figure 2-5. Median Width includes

inner Shoulders.

]

al
3

Figure 2-5. Median width in PHD

NOTE: Segmentation is not required based on small changes in Median Width. However,
segmentation is required based on significant changes in Median Width and/or changes in
Median type (i.e., going from a divided to undivided median).

2.1.3 Lanes/Shoulder, Curb & Gutter Details

Lane,
Shoulder, and
Curb & Gutter
Details

Lanes and shoulders are as defined by the roadway pavement markings. If work has occurred
on a particular lane, then the user needs to enter its width, lane type (function), surface type
(which describes the pavement cross-section), and layers. Similarly, if work has occurred on a
shoulder side, the user needs to identify whether it has corrugations (rumble strips), has
parking, its paved and total widths, surface type, and layers. If a curb & gutter side has been
constructed or replaced, then its type needs to be selected.

11



2.1.4 Layer Details

Lane & A layer is a single thickness of a paved/placed material or repair work. Examples of
Shoulder paved/placed material include HMA Top/Leveling/Base courses, concrete pavement, chip
Layers seal, etc. Examples of repair work include asphalt joint/crack repair, concrete pavement

repairs (Detail 7's & 8's), HMA cold milling, Overband Crackfill, etc.

GOTE 1: In PHD, layers should be entered in order of construction. For example, IayeD
for Crush & Shape and Asphalt Resurfacing job (with milling) should be entered in the

following order from bottom (layer 1) to top (layer 4): Layer 1 is Cold Milling, Layer 2 is

Crushed and Shaped HMA, Layer 3 is HMA Leveling Course, and Layer 4 is HMA Top

Course.

NOTE 2: Only the layers paved/placed in the current job should be entered. Existing

ders or layers paved/placed in other jobs should not be entered with the current joky

Layers Input Figure 2-6 shows a pavement cross-section of a “Milling and Two Course Asphalt Resurfacing”

Examples project. In this case, the following layers will be entered in PHD in the following order from
bottom to top: Cold Milling, HMA Leveling Course (4EML), and HMA Top Course (5EML). Any
existing HMA and aggregate base layers should not be entered in the current job in PHD.

9'SHLD 12' LANE , 12' LANE 9'SHLD _1'MAX
<2 8' HMA 8 HMA
AGG (5EML)
[ e
4EML - AENL
2% \ 2%
4% <25 4%
Eats i ER—— F———--=C I —=r g B
e — — - { = 1 -
EX 6" HMA
EX 8" AGG / EX 8.5" HMA -
EXAGG/CONC EX 6" AGG

Figure 2-6. Layers Input Example 1

Figure 2-7 shows a pavement cross-section of an asphalt reconstruction project. Note that only
the auxiliary lane and the right shoulder need to be entered in PHD, with the following layers:
Sand Subbase, Aggregate Base, HMA Base Course (3EMH), HMA Leveling Course (4EMH), and
HMA Top Course (5EMH). Existing lanes and shoulders should not be entered with the current

job.
PROP AUXILIARY PROP SHLDR
L EREET T ; Exa | . | LANE 12' | I 8' | |
‘ EX @ PAVED
SEMH
PR CP AEMH
MATCH MATCH MATCH 3EMH
| W EX % EX 21 [
.5 3 —— e - £
— o — e = — — ——— = -—— el —
- Jj*’ i de === ==3= = - ":\&\O{‘EVA
g Eim ~dez======3=;j======== -
T _7”__7—7} ——————— **_EL""""”*L foo. BEL fies
v =
EX CLASS A SHOULDER / E¥ RUBBLIZED CONC EX HWA SURFACE Y — — — —
& :xunlna BASE rEEXSTSU'EB;gE / el (EST & 5 = & IFsUBBASE 18INCH
TR S — ,/ (or a e HORia AGGREGATE BASE, 6 INCH
UNDERDRAIN, 18 INCH (TYP)

Figure 2-7. Layers Input Example 2
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2.1.5 Layer Attributes

Layer Each layer contains a unique set of attributes to characterize and/or define the material or
Attributes repair work. Examples of HMA layer attributes include HMA Application Rate, Asphalt Binder
PG and Source, Mix design Number, and Aggregate Type and Source. Examples of concrete

layer (PCC Pavement) attributes include Concrete Thickness, Cement Content, and Cement
Type and Supplier. Users need to select (or enter) as many pavement attributes as possible,
even if only some of the attributes are required.

Attributes Figure 2-8 shows different -
Layers Attributes
Input layers from an HMA | s HmA Top Course | ¥ AWI (only Top Course) ' Mix Type
. . . E—— v Application Rate v’ Mix Design Numb
Example reconstruction job, with the e HMA Leveling Course [~ v/ asphalt Binder e
. . - v i i :
required attributes. A Rty | | TrolLnOSTSOfipler. < Spingles yesdy
v Aggregate Class v’ Aggregate Source

comprehensive list of all layers
and their associated attributes
can be found in the Data Entry
Items document available on

Aggregate Base

2 Course v Thickness

L v/ Aggregate Class
v’ Aggregate Source

Subbase

]—\/Yes/No

Figure 2-8. Layers attributes Example

the PHD Informational website.

2.2 Job Preparation

Job Before entering job data details in PHD, Data Entry users should obtain project construction
Preparation records. Below is a list of the most common construction records required for PHD entry.
Other construction-related documents and forms might be required as well.

» Project plans and proposal which include project location (PR numbers and milepoints),
typical sections, work items, etc. “As Built” plans are preferable, but if project information
is being entered soon after construction, these might not be available.

» Contract modifications to check for material changes made during construction.

» HMA Job Mix Formulas (JMF) (MDOT Form 1911) and concrete JMF (MDOT Form 1976).

> Report Of Quality Assurance Testing (MDOT Form 1903B) and Weekly Summary Of
Certified Concrete (MDOT Form 1155).

» Material Source List (MSL) (MDOT Form 0501), and the Material Certifications, Certificate
of Compliance, and/or Certificate of Analysis.

» Testing orders for surface seals and crack treatments.

> Delivery tickets (HMA, concrete, aggregate, etc.).

> Inspector’s Daily Reports (IDRs) (MDOT Form 1122B), Inspector’s Report of Concrete
Placed (MDOT Form 1174R), and/or Aggregate Inspection Daily Report (MDOT Form
1900).

> Record of Soils Recommendations (MDOT Form 0583)

NOTE: If the construction documents for Non JobNet Jobs are unavailable or incomplete,
contact personnel who have direct knowledge of the work done and gather project related
documentation. Enter as much accurate information as is available.
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https://www.michigan.gov/mdot/-/media/Project/Websites/MDOT/Business/Construction/Pavement-Operations/Pavement-Historical-Database/Data-Entry-Items-in-PHD.pdf?rev=6b826a6c69a441e3929ad9aa6f515b01&hash=B3CFC979E9F76935DD84B426F4EE042F
https://www.michigan.gov/mdot/-/media/Project/Websites/MDOT/Business/Construction/Pavement-Operations/Pavement-Historical-Database/Data-Entry-Items-in-PHD.pdf?rev=6b826a6c69a441e3929ad9aa6f515b01&hash=B3CFC979E9F76935DD84B426F4EE042F
https://www.michigan.gov/mdot/business/construction/pavement-operations/pavement-historical-database

Table 2-3 details the most common required inputs in PHD and the main source for such

inputs. The complete list of PHD data sources is available in the PHD Attribute Locations

document, which is available on the PHD Informational website. Several resources can be

used to find information needed for data entry, including the following:

Y/
0'0

@,
0’0

ProjectWise: MDOT’s electronic document tool used to manage documentation for
construction projects. Consultants can be granted limited access to MDOT’s ProjectWise
folders to gather construction-related documents. Most construction records required for
PHD entry (mentioned above) can be gathered from ProjectWise.

MDOT PR Finder: an online mapping application that helps to identify the PR number and
milepoints for all roads in the state of Michigan. This website is open to the public.
MDOT Construction Contract Inquiry (CCI): an online database with project-specific

information, such as contract-level information, contract modifications, and contractor
payments that reflect “As Built” information. CCl database is open to the public.

Google Maps/Google Earth: tools for aerial imagery. In many cases, the Google aerial
imagery is captured recently (and after the project’s completion date). In this case, certain
pavement features can be verified, such as the number of lanes, lane type, lane width,
shoulder width, median type and width, and others.

Before starting the data entry process, check the following:

@)

Check if the project qualifies as a “Special Project Type” such as CPM Emerging
Technology or Pavement Demonstration projects. If yes, this should be indicated at job
creation. Typically, the TSC and Region Offices know if the project meets this designation.
Check if the project qualifies for the Simplified CPM format (projects with WTC 400-499).
See Chapter 5 for further details. This format requires less data entry, thus requires less
time, and can be utilized for either JobNet Jobs or Non JobNet Jobs. The simplified CPM
format should not be used if the project includes any HMA paving.

Table 2-3. Most common required inputs in PHD and the main source for such inputs

Data Entry Level

Required PHD Inputs*

Data Source

Job Details

Work Type Code, Fix Life

For JobNet Jobs - automatically generated in PHD
For Non JobNet Jobs - Project plans & proposal

Non JobNet Job Type

Only for Non JobNet Jobs - see Table 2-2

Special Project Type

Project plans & proposal

Open to Traffic Date

Inspector’s Daily Reports (IDRs)

Segment information (PR#, BMP, and EMP)

Segment Details

Number of Lanes, Shoulder Details, Median
Type and Width

For JobNet Jobs - automatically generated, but
modifications may still be needed depending on the
Project plans & proposal

For Non JobNet Jobs - Project plans & proposal

Lanes/Shoulder,
Curb & Gutter
Details

Lane Surface Type (pavement cross-section),
Lane Width, Lane Type, and Lane Layers

Shoulder Surface Type (pavement cross-
section), Shoulder and Curb & Gutter
Details, Shoulder Layers

Project plans & proposal
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https://www.michigan.gov/mdot/-/media/Project/Websites/MDOT/Business/Construction/Pavement-Operations/Pavement-Historical-Database/PHD-Attribute-Locations.xlsm?rev=bb08e201a1b240988f8010465aaea620&hash=9117FB05361BA96665B1355F335507FD
https://www.michigan.gov/mdot/business/construction/pavement-operations/pavement-historical-database
https://mdotgis.state.mi.us/portal/apps/webappviewer/index.html?id=c3aa2462a1e24e37a33184a33e5976aa
https://mdotjboss.state.mi.us/CCI/home.htm
https://www.google.com/maps

Table 2-4. Most common required inputs in PHD and the main source for such inputs (continued)

Data Entry Level Required PHD Inputs* Data Source

Layers/ Repair HMA Layers

Work Attributes Application Rate Project plans & proposal, IDRs (Form 1122B)
AWI, Asphalt Binder, Asphalt%/%Added, JMF (Form 1911), Report of Quality Assurance (Form
Asphalt Binder Cert. Supplier, Mix Design 1903B), IDRs (Form 1122B)

No., Mix Type, Shingles & Warm Mix use

Aggregate class and Source (pit) number JMF (Form 1911)

Concrete Layer (PCC Pavement)

Cement Content, Supplier, and Type; Fly Ash  JMF (Form 1976), Weekly Summary of Certified
Content; GGBFS Concrete (Form 1155)

Thickness, Transverse joints sealed (yes/no) IDRs (Form 1122B)

Transverse joint spacing MDOT Std Plan R-43

Aggregate class and Source (pit) number JMF (Form 1976), Certified Concrete From (1155)

Aggregate Base Course, Subbase Layer

Thickness IDRs (Form 1122B), Project plans & proposal

Aggregate class and Source (pit) number Aggregate Inspection Daily Report (Form 1900), MSL
(Form 0501)

Crushed and Shaped HMA, Rubblized Concrete Pavement

Thickness IDRs (Form 1122B), Project plans & proposal

Chip Seal Layer, Micro-surface Layer, Scrub Seal Layer, Slurry Seal Layer

Emulsion Type and Supplier MSL (Form 0501), Material Certifications, Certificate
of Compliance, and/or Certificate of Analysis

Number of courses IDRs (Form 1122B)

Aggregate class and Source (pit) number Aggregate Inspection Daily Report (Form 1900), MSL

(Form 0501)

Joint/Crack Repair Mastic

Asphalt Repair Mastic Product MSL (Form 0501)

Concrete Pavement Repairs (Detail 7’s & 8’s)

Detail 7’s placed (yes/no), Detail 8’s placed IDRs (Form 1122B), Project plans & proposal

(yes/no)
Detail 7 and Detail 8 mix type JMF (Form 1911), Quality Assurance Report (Form
1903B)
Cold Milling
Cold Milling Depth, Texture, and Type IDRs (Form 1122B), Project plans & proposal

* These are the most common required inputs in PHD and do not represent the full list. The complete list of PHD data
source is available in the PHD Attribute Locations document, that is available on the PHD Informational website.
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https://www.michigan.gov/mdot/business/construction/pavement-operations/pavement-historical-database

Chapter 3. Introduction to the PHD System

3.1 PHD User Interface and Navigation

User
Interface

Main and
Secondary
Menus

PHD is a web-based application hosted through the State of Michigan MILogin website, and
opens in a web browser (e.g., Microsoft Edge, Google Chrome), as shown in Figure 3-1. Upon
opening the PHD application, the “Welcome” screen is displayed. The Navigation Panel on
the left side of the window contains the available menus (Post Construction Data, Reports &
Searches, and Administration) and their secondary menus. The top of each page in PHD
retains the same “header”. The header displays the user’s name, the user’s role (Read Only,
Data Entry, or Data Owner), and the user’s location assignment (Statewide, Region, or TSC).
The header also contains clickable links to additional resources, such as PHD Help (displays
the PHD User Guide in a new window). Users should click on Sign Out when exiting the

application.
T T
- Department of @ ,
“i DOT UG LN HLUATERTL
a—— 2
connectMDOT Home PHD Home | PHD Contact | PHD Help Sign Out
Fawaz Kaseer Pavement Historical Database 1 |

4 :: Post Construction Data | Welcome I Role[s] i1 Data Owner , System Administrato

- Post Constr. Data
The Pavement Historical Database (PHD) is a centralized electronic data warehouse created for the
Create collection and storage of pavement “As-Built” typical section information and materials data on
Michigan's state routes. PHD collects information from the typical sections of the as-built plans and the
project mix designs, and then combines it in a centralized electronic format using the project specific
PR numbers and mile points from the MAP database as a linear referencing system. In addition to
simply storing this data, PHD also functions as a research tool. The data can be quickly and easily
searched through, sorted and exported. The historical records contained in PHD provide the basis for
an improved pavement management system and have uses including pavement management data
analysis, materials trend analysis, asset management, sufficiency, and scoping and estimating of
proposed highway construction projects by region and TSC personnel as part of the annual Call for
Projects process.

Modify
Review

Reassign

+ Reports & Searches

+ Administration

Figure 3-1. PHD Interface and Welcome Screen

The Navigation Panel on the left side of S Rapors ® Semrches - Atminiatration
the window contains the main menus | . create » Export Data » View/Modify User
(Post Construction Data, Reports & » Modify 7 Seaich Segment(a) B | /(Crata Unit
Searches and Administration) and » Review » Construction History » View/Modify Unit
. ! R » Reassign » Material Information » Create Attribute
their submenus, which serve as ‘ ) ) ) ) S
» Layers Library » Material Quantity » View/Modify Attribute
navigation links to the PHD screens. 5 Natwork Tnvantory o Cranta Layer
Menu availability is based on the » Work Type » View/Modify Layer
assigned user role. Figure 3-2 displays 2EMAP Reconclliation) [ 7 Deteta Job
. » Unlock Report
all main menus and submenus.
» HPMS Report

Figure 3-2. PHD Menus
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Back, Cancel,
& Save

Back, Cancel, and Save buttons are displayed throughout many different screens in PHD. It
is important to understand the functionality of each of these buttons, as explained below:

> Back
= Returns to the previous screen.
= WARNING: Any changes made since the last save may still appear if the screen is
reentered, but they are not saved. Data will be lost if a project is exited without saving
the changes.
» Cancel
= Leaves the current job and returns to the initial submenu screen.
= WARNING: Entered data will be lost if it is not saved.
> Save
= Saves the data entered on the current screen.
= WARNING: Selecting save does not save data on other screens. For example, multiple
lanes can be created and edited. Selecting save does not save all lanes, only the current
lane on the screen. Save often and make sure to save before moving to a new screen.

3.2 Page Headers

Active
Screen
Display

Project &
Segment
Display

The Active Screen display, located below the header and next to the Navigation Panel,
indicates the main menu and active submenu the user is in. In Figure 3-3, the main menu is
Post Construction Data, and the active submenu is Modify List.

Role[s] :: Data Owner, System Administrator

e [search Fike ___________________________________ [Hide]V]
»  Modify Job Type : O JobNetJob ) NonJobNetJob @® Both
ol R Work Type s \Any v
> Resssion Jobet Job Detals
»  Layers Library JobNetJob . [ 5| Non JobNet Job 1d [% |
|+ Reports & Searches Non JobNet Job Type : [Any v
+ Administration (RoptyFiter] (FosetFiter]

Figure 3-3. Active Screen Display: Menu & Submenu

The active project and its identifiers (job number, PR number, and beginning and ending

milepoints of the active segment) are displayed below the Active Screen display, as shown in
Figure 3-4.

R Department of

B i ——

e e e oo e

connectMDOT Home PHD Home | PHD Contact | PHD Help
Pavement Historical Database i

< :: Post Construction Data | Segment Overview Role[s] :: Data Owner, System Administrator|

S Segment Details [ Job # - 124046 / PR # - 6200103 / MP : 0 ... 0.083 ] [Show] A
Modify
- Review

Figure 3-4. Project and Segment Display
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3.3 Screen Prompts

Required
Fields

Error &
Confirmation
Messages

Screen Tips

A red asterisk designates a required field, as
shown in Figure 3-5. Required fields need to be
completed before going to other screens or saving
data.

*
= Required Fields

Enter Job Information

*
IsJobNet Job @ @ ves O no

*
JobNetJobto ([ ]

| Next Step | | Cancel |

Figure 3-5. Required Fields

Red error messages designate a warning or a notification, so inputs must be corrected before

going to other screens or saving data. Conversely, a green confirmation message will appear

when a record is successfully saved, updated, or completed, as shown in Figure 3-6.

A\ Project ID [1548754] already exists in PHD.

Enter Job Information

* .
Is JobNet Job - ®ves Ono

& Job [FKAPP026952] has been saved as a Draft.
PR Segment List

PR
Number

1725010 4.36 M-65
* JobNet Job ID O 2 1891001 22 O 0.079  M-72
O 3 1851001 22 0.079 6.93 M-72

[ Next Step || Cancel | ( Details | | Copy Segment Details | [create segment

Figure 3-6. Error and Confirmation Messages

Hovering the mouse (cursor) over a command button triggers a visual screen tip, as shown in

Figure 3-7.

by

Select New Layer Shoulder Sections
EC e — e

1 HMA Top Course Draft

‘ Click to add the selected layer to the shoulder & enter the layer details ‘

Figure 3-7. Screen Tips
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3.4 List Features

Sort Lists Lists can be sorted, in ascending or descending orders, by the column header. A triangle
symbol in the column header displays the current sort header criterion. For example, the
table in Figure 3-8 is sorted by the Job ID in ascending order. The table can be sorted by a
different column (by PR BMP, for example) by clicking the desired column header. The arrow
will then appear in the newly selected column. The currently sorted column can also be sorted
in the other direction by clicking on the arrow.

o 01 o ]
EI 696 47171 1.192 11/23/2010 [&]
EI 656 47171 710701 1.192 1.351 11/23/2010 [=]
EI 696 118417 710701 0 1.25 10/15/20153 [2]
EI 656 118747 710701 1.195 8.559 08/04/2013 [f]
EI 656 132113 710701 1.19 9.861 11/04/2018 [al

Figure 3-8. Sort List

Search Filter Lists can be filtered to display a limited list of items containing specified details. Figure 3-9
shows an example of the search filter in the Modify submenu. Entering the % symbol in text
box filters serves as a “wildcard”. Table 3-1 includes some examples of using the wildcard.

Search Filter [Hide ]¥

Job Type © @ jobNetJob O Non JobNet Job O Both
Work Type : | Any V|
JobNet Job Details Non JobNet Job Details
JobNet Job | o5 || Non JobNet Job Id : |% |
Id ’
Mon JobNet Job Type | Any V|

[Apply Filter | [Reset Filter |

Figure 3-9. Search Filter

Table 3-1. Wildcard Descriptions

Wild Card Description

8% Returns any number, word, or phrase beginning with an “8”
%8 Returns any number, word, or phrase containing “8”
8%3 Returns any number, word, phrase beginning with “8” and including a “3”
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Chapter 4. Create and Modify Jobs in PHD

4.1 Create Jobs in PHD

Create Follow the steps below to create JobNet Jobs:

JobNet Jobs 1) Click Create from the Post Construction Data menu (in the left navigation bar).

2) Enter the Job ID, omitting the phase
identifier suffix (i.e., omit the letter “A” in
208494A or “CON” in 208494CON, and
enter the JobNet ID 208494).

 :: Post Construction Data | Create New
- Post Constr. Data

* . .
Create = Required Fields

> Modify Enter Job Information

» Review *
Is JobNet Job @ @ ves Ono

*
JobNet Job ID 208494

» Reassign

Layers Library

+ Reports & Searches [ Next Step I Cancel |

3) Click Next Step, and fill out/select the required fields in the Job Details screen.

> If the jobs qualify for Simplified CPM Format, then select “Yes” for Simplified CPM
Format. For more details, see Chapter 5 for Simplified CPM Format Jobs.

> If applicable, select the appropriate Special Project Type.
|

JobNet Job ID : 208494
Work Type Code : 443 - One Course Asphalt Overlay
Fix Life : 10 Year(s)

* Use SIMPLIFIED CPM format for data
entry? [only use when all lanes and work ~ * Oves @no
is the same]

O CPM Emerging Technology Funded

Special Project Type ) ) pemonstration Project
[Choose upto two types] " [ National Pavement Studies

O state Pavement Studies

* Open to Traffic Date

[This is the date when all lanes are open

to the public traffic. For multi-year . [mm/dd/yyyy]
projects, please estimate it for now and

use a placeholder to come back and

change it later.]

[ Back | [ save & Next| | cancel ]

GOTE 1: To qualify as a Special Project, the job needs to be one of the following: (1))
Pavement Demonstration Program project, (2) a CPM Emerging Technology Program
project, (3) a state pavement study [must include a study number], and (4) a federal
pavement study [must include a study number].

NOTE 2: Open to Traffic Date is the date when all lanes are open to public traffic. For
multi-year projects or projects not yet complete, an estimated date can be used as a
Qaceholder, which can be changed later (before finalizing). )

4) Click Save & Next to continue. The Road Segment List screen opens and displays a list

of all road segments (in the PR Segment List tab) identified from the JobNet database.
These segments can be adjusted, or new segments can be created as needed.
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Create Non
JobNet Jobs

Follow the steps below to create Non JobNet Jobs:

1) Click Create from the Post Construction Data menu (in the left navigation bar).

2) Click “No” for the “Is JobNet Job” and enter
the Job ID. Follow the guidelines listed in
Table 2-2 for the Non JobNet Naming
Convention.

» Create
» Modify
» Review

» Reassign

Layers Library

+ Reports & Searches [

4 :: Post Construction Data | Create New
- Post Constr. Data I

*
= Required Fields

Enter Job Information

: Oves @no
;| M147854

*
Is JobNet Job

) Non JobNet Job ID

Next Step J cancel ]

3) Click Next Step, and fill out/select the required fields in the Job Details screen.

> Select the Non JobNet Job Type and the Work Type Code (WTC) which most closely
matches the work performed as part of this Non JobNet job.

» Once a WTC is selected, the Fix Life will be auto-filled. If the Fix Life per project is a range
of low and high values, PHD will auto-populate the highest value. The user may enter a
different value as needed. Click on the Fix Life Guide link to review the appropriate Fix
Life per project type. Consult the appropriate Pavement Management Engineer for

further guidance or confirmation.

» If the jobs qualify for
Simplified CPM Format,
then select “Yes” for
Simplified CPM Format.
For more details, see
Chapter 5 for Simplified
CPM Format for PHD Jobs.

Non JobNet Job ID
*

Non JobNet Job Type
*

Work Type Code

*
Fix Life

Special Project Type
[Choose upto two types]

* Open to Traffic Date

[This is the date when all lanes are open
to the public traffic. For multi-year
projects, please estimate it for now and
use a placeholder to come back and
change it later.]

» If applicable, select the

appropriate Special

Job Details

. [o813172023 [EEe] tmm/ddryyyy

: M147854

: ‘ Maintenance "M" Funded v ‘

: ‘ 684 - Milling and Two Course Asphalt Resurfacing v

: Year(s) Fix Life Guide

O cpm Emerging Technology Funded

[ pemonstration Project

[J National Pavement Studies
[ state Pavement studies

[ Back | save & Next| [ cancel

Project Type.

pavement study [must include a study number].

GOTE 1: To qualify as a Special Project, the job needs to be one of the following: (1)}
Pavement Demonstration Program project, (2) a CPM Emerging Technology Program
project, (3) a state pavement study [must include a study number], and (4) a federal

NOTE 2: Open to Traffic Date is the date when all lanes are open to the public traffic. For
multi-year projects or projects not yet complete, an estimated date can be used as a
(Iaceholder, which can be changed at a later (before finalizing).

J

4) Click Save & Next to continue. The Road Segment List screen opens, but segment

datais not pulled into PHD as it is with JobNet Jobs, so all segments must be manually

created.
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4.2 Modify Jobs in PHD

Modify
Submenu

Road
Segment List

Once a job has been created, it can be later edited/modified (unless it has been Finalized).
Begin editing a job (1) immediately after the PHD job is created from the Create submenu, or
(2) by selecting a previously created job from the Modify submenu. Select the Modify
submenu from the Post Construction Data menu (in the left navigation bar). The Modify List
screen will display, and will be populated with jobs created by (or assigned to) the current
user. Select a job to enter/modify the data. Once selected, the job’s Road Segment List screen

will open.
e ——— 422 Post Construction Data | Modify List Role[s] 22 Data Owner, System Administrator
Search Filter [Hide ] ¥
» Create
Job Type © O 3obNetJob O NonJobNetJob @ Both
S Review Work Type : |Any V|
» Reassign JobNet Job Details Non JobNet Job Details
» Layers Library JobNet Job | ]| Non JobNet Job Id .
1d .
+ Reports & Searches Non JobNet Job Type ‘ Any V‘
+ Administration (Berly Filter] (Raset Fitar]
JobNet Job Non JobNet
109854 110—Non-Freeway Sign Replacement
124046 — — 120—Intersection Improvements
132102 — - 160—Reconstruction
201214 — — 167—Crush & Shape & Asphalt Resurfacing
208494 - - 443—0ne Course Asphalt Overlay
Page: 1 of 4
[<If<] 12 3 a

In the Road Segment List, the PR Segment List displays a list of all road segments in the
selected job, including segment-specific location information such as PR number, BMP, EMP,
Route, and data Status.

The Road Segment List is the main page 11 Post Construction Data | Road Segment List Role[s] : Data Owner, System Administrator
;
for completing the data entry for any [ Ses=EiEEEtumIindt .
specific job. Users can enter Segment
. e eTon Framework Data
Details, Create Segments, Delete Iﬂ@mm-
1175102 5284 M-26 2way  Active Dra
Segments[ and c°py Segment Details O 2 1270204 22 5.519 6.560 M-26 2Way  Active Draft
O 3 1270204 22 6.563  6.652  M-26 2Way  Active Draft
from one Segment to another' Users can O 4 1270204 22 6.652 6.696 M-26 2 way Active Draft
O 5 1270204 22 6.696 7.669  M-26 2way  Active Draft
aISO change the PR Segment Mile Points O 6 1270204 22 8957 10.431 M-26 2 way A(tive Draft
© 7 1270204 22 10431 15522 M-26 2Way  Active Draft
for any Segment and can Create Sub () 8 1270708 22  11.775 13.305 M-38 2Way  Active Draft
’ [ seamentDetails | [ CopySegmentDetails | [Create Segment| [Delete Segmentis)|

Segments (i.e., splitting the segment into

u No. of Sub Segments \:I [At least 2]
1 1175102 Em (Creste b Seamenis]

For the Data status in the PR_Segment

two or more subsegments).

List, please note it always starts at the —
roje: omments
[max 250 characters]

“Draft” status for each segment, and )

( Back | [Finalize Job| [Save Job as Draft| | Cancel ]

Project Summary

once the data entry for each segment is

saved as complete, it will change to
“Complete” status. The job cannot be finalized until all segments show a “Complete” status.
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(NOTE: As mentioned previously, preliminary segment information (PR numbers and\
milepoints) will be generated for JobNet Jobs. However, modifications to those segments
or additional segments may still be needed depending on the “As Built” project information.
For Non JobNet Jobs, preliminary segment information is not automatically generated, so
all segment data needs to be entered. Please follow the Segmentation Rules in Chapter 2

kwhen creating or modifying segments. )

4.2.1 Create and Modify Segments

Create
Segments

Follow the steps below to create segments in PHD:

* = Required Fields

Create PR Segment [ Job # - 208494 ]

1) Click Create Segment under the PR
Segment List screen.

Latest PR Version pRr Numher* BMP* EMP*
2) Enter PR Number, BMP, and EMP, [* < 1270708 12308 15968
and CIICk create [ Create and Add One More ] [ Back l

NOTE 1: If the milepoints overlap another segment, or if the milepoints exceed th?
milepoint range of the PR number, an error message will occur. Therefore, make sure
that correct PR number and milepoints were entered.

NOTE 2: Use PR Finder as a resource to identify the PR number and milepoints for all

roads in the state of Michigan. )

3) If the project has a new ramp, roundabout, or alignment changes, the new PR number
cannot be entered with the latest PR Version. To enter such segments, follow the steps

below:
> Select “Future” under the Latest | * = required Fields
PR Version, and Create the |EEOLrTi Ity
segment. The Framework Status of | “stPRYersion. PR Number" Bue” Eme”
’ 1690708 0 5.899
such a segment in the PR Segment
List will show as “Inactive”. [ CresteandAddonemore | [ Back
PR Segment List [Hide ]V
> Complete the data ety for | e e e i
. Number Status Status
any “Inactive” segment(s) ['g . iscoroe o 589 Drat

QO 2 1270708 23 0 0.422 Greenland Rd Active Draft

and save it as “Complete”.

O 3 1270204 23 5.519 6.569 M-26 2 Way Active Draft

» After completing the data entry for all other segments, save the entire job as “Draft”.
Users cannot finalize the job until the Framework Status shows an “Active” status.

> In the next year’s PHD data entry cycle, and when the new (or changed) alignment is
reflected in the PR framework, create again the same segment. The Framework Status
of such a segment in the PR Segment List will show as “Active”.

» Copy segment details of the “Complete” and/or “Inactive” segment to the newly
created “Active” segment. Delete the “Inactive” segment. Please refer to the Copy
Segment Details section for more information. Information on Deleting a segment can

be found on the next page.
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Change
Segment
Milepoints

Create PR
Sub
Segments

Delete
Segments

Follow the steps below to change the milepoints for any segment:

1) Select a segment from the PR Segment List pane. Milepoints are displayed in the Change

PR Segment Mile Points pane.

2) Modify the BMP and/or EMP in the Change PR
Segment Mile Points pane text box(es) and click

Apply Milepoint Changes to update the road

segment.

Change PR Segment Mile Points
4 [pRNumberlowp  Ewe |

2 1175102 | ol | 5.284]

Apply Milepoint Changes

To divide an existing segment into two or more smaller segments:

1) Select a segment from the PR Segment List pane.

2) Enter the Number of Sub Segments |G- F—

desired, (at least 2) in Create PR Sub
Segments pane text box and Click Create

Sub Segments.

3) Manually enter the BMP and
EMP for each subsegment.
Click Create Sub Segments.

No. of Sub Segments : [At least 2]

Create Sub Segments
4 :: Post Construction Data | Create Sub Segments Role[s] i: Data Owner, System Administrator
Road Segment [ Job #-208494 /| PR #- 11756102/ MP : 0 ... 5.284 ] [ Show] A&
PR Sub Segment Summary Add an additional PR Sub Segment

DI e ) o [
01 wmrswz | o 1.500 —

0 2 175102 1.500 4.555

0 3 1175102

Back | [Create 5ub Segments

Follow the steps below to delete |u setectsegment(s) to gelete.

any segment:

1) Under the PR Segment List pane,

click Delete Segment(s).

2) Select the segment(s) to be

deleted. Click Confirm.

PR Segment Details [ Job # - 208494 ]

[PR Segment Detals [Job#-2084941 |
|8+ | e PR WP WP | RoueJoreaon) PR | S, |
1 1650708 Q 5.899 Inactive Draft
0 =2 1175102 22 0 5.284 M-26 2 Way Active Draft
Qg s 1270204 22 5.519 6.569 M-26 2 Way Active Draft
O 4 1270204 22 6.569 6.652 M-26 2 Way Active Draft
(-1 1270204 22 6.652 6.656 M-26 2 Way Active Draft
O s 1270204 22 6.696 7.669 M-26 2 Way Active Draft
o 7 1270204 22 8.957 10431 M-26 2 Way Active Draft
O s 1270204 22 10.431 15.522 M-26 2 Way Active Draft
O o 1270708 22 11.775 13.305 M-38 2 Way Active Draft
I Back [ Confirm |




4.2.2 Edit Segment Details

Segment
Details

To enter the Segment Details screen, and begin adding and/or editing Segment Details, select
the radio button of a segment from the PR Segment List pane, then click Segment Details.

The Segment Overview screen displays (for the selected segment), and users can:

» Click Lane Details to add, remove, and
define segment lanes (see section 4.2.2.1).

» Click Shoulder, Curb & Gutter Details to
add, remove, and define shoulders or curb
& gutter (see section 4.2.2.2).

> Select Median Type & Width, and enter
segment comments in the Segment
Comments box (see sections 4.2.2.3 and
4.2.2.4).

4.2.2.1 Lane Details

Segment Details [ Job # - 208494 / PR # - 1175102 /MP : 0 ... 5.284 ] [Show] A

Segment Shoulder Overview Segment Lane(s) Overview

2.0 Yes Draft
1.0 Yes Draft

:

Segment Curb & Gutter Overview

workbone [

* Median Type * [Undivided v

Segment Comments

[max 250 characters]

4
Back Save Segment | [ Save Seament As Draft| [Segment Summary Cancel

Segment
Lane(s)

In the Segment Details screen, and under the Segment Lane(s) Overview, the number of
lanes will be shown if available from the MDOT’s Road Asset Inventory database. If lanes are
not automatically populated or if incorrect, then the user needs to create or delete the lanes
as needed. Use the following steps to add and/or edit Lane Details:

1) Click Lane Details button from the

Segment Overview screen. Segment ccted L
. . . . . . @ves 1.0
lanes and their details will be shown (if [ etiene  Lene 20 Work® O

Add Left Lane| [Add Right Lane | [Copy Lane| [Remove Lane

lane(s) are previously added).

2) Add Lane - Left Lane, or Right Lane to

NOTE: Lanes are always numbered right to left facing toward increasing milepoints of the PR
segment:

- Lane 1 is the right-most travel lane of the PR segment.

- Increasing lane numbers 2, 3, and greater are lanes left of Lane 1.

- Decreasing lane numbers 0, -1, and less are lanes right of Lane 1

create new lanes. Please review the

Lane & Shoulder Numbering guidelines. Left Lane and Right Lane indicate which side of the
currently selected lane the new lane will be added.

3) If alane exists in the system, but no work has been done on the lane in this job, select “No”

in the Work Done option.

4) Select different lanes (within the same segment) by using the Select Lane drop-down list
in the Segment Lanes pane to edit details or add layers for that lane.

5) Enter lane details such as the Surface Type,
Width, and Lane Type in the Lane Details pane.

Please note the following:

> For the lane Surface Type (pavement cross-
section), all existing layers underneath the
top surface placed with the project should be

considered. Consider the

scenarios:

Lane Details [ Lane #1.0 ]

*
Surface Type

(pavement cross- : [ HMA over existing HMA v
section)
*
width S FERE |
* Lane Type : | Select Lane Type v

* Year [Paved/Placed] [yyyyl

*
Pa_rtlal Width s Oves ®no
Paving?

following
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Examples of
Surface Type
in PHD

= |f the entire pavement was replaced in this job with asphalt, then the surface type is

(HMA Full Depth). Similarly, if the entire concrete pavement was replaced in this job
with new Jointed Plain Concrete Pavement (JPCP), then the surface type is (JPCP).

If an HMA overlay occurred in a lane with existing HMA but without any existing
concrete pavement, then the surface type is (HMA over existing HMA).

If an unbonded concrete overlay occurred in a lane with existing concrete, then the
surface type is (Unbonded Concrete Overlay on Existing Conc). Note that if an HMA
separator layer is used, this would still be considered (Unbonded Concrete Overlay
on Existing Conc.

If an HMA overlay occurred in a lane with existing concrete pavement (regardless of
directly or indirectly below the new overlay), then the surface type is (HMA over
existing Jointed Conc).

Please note that for a cross-section that is made up of existing concrete, a very thick
aggregate overlay, and new HMA pavement, the surface type is considered (HMA Full
Depth). The existing concrete is deep enough that it does not significantly affect the
surface HMA pavement. A note can be added to the Project or Segment Comment
box to indicate this deep existing concrete.

If HMA layers constructed in a lane with Rubblized Concrete, then the surface type is
(HMA Full Depth).

For Micro-Surface, Chip Seal, etc., if the thickness 20.5", then this is considered as a
structural layer, and the surface type is HMA over existing HMA/Conc. If the thickness
<0.5", then this is NOT considered as a structural layer, and the surface type is
determined considering the existing layers only. Even if the layer is not considered a
structural layer, it must still be entered into PHD as a layer.

» For the Lane Width, if only a partial width of this lane was paved and not fully paved by

the end of the project, select “Yes” for “Partial Width Paving?”, and select the partial

paving width from the list.

. [Core Section{Lone# 0] |
6) Add layers to the selected lane in the Lane (3] topetame | DY g

Section pane. To enter a new layer, select a layer | : H14 Top Course ot O

A . 1 Cold Milling Draft O

from the drop-down list, and then click Add

Layer.
Layer : |Se|ect a Layer V‘

Users can also select a layer from the Layers

Library. Please refer to the Layers Library section

Layer : |Se|ect a Layer v \

for more information.

Add Layer

clicking on Move Up or Move Down. Similarly, layers can be removed from this list.

NOTE 1: Layers required for entry include all new materials and milling/repair work to
existing layers.

NOTE 2: Only the layers paved/placed in the current job should be entered. Existing
layers or layers paved/placed in other jobs should not be entered with the current job.

Re-order the layers, if necessary, by selecting the check box of the layer(s), and then



Lane Layer(s)

1) Click on an added layer in the
Lane Section pane, and the
Layer Details screen will appear.
In the Pavement Attributes

For each layer added in the Lane Section pane, use the following steps to edit Lane Layer(s):

pane, select or enter each

material attribute.

Select a Layer [ Job# - 208494 / PR # - 1270204/ MP :5.519 _. 6569 ]
Layer :

The application of a polymer modified asphalt emulsion with a cover aggregate. A single or a
double chip seal can be used.

Locate layer attributes using the following construction-related documents:

- For Emulsified Asphalt Supplier and Emulsion Type, use Material Source List (MSL) (Form 0501).
- For Mumber of Courses, use Inspector’s Daily Reports (IDRs) (Form 1122B) or ‘As Built’ Plans &
Proposal.

- For Aggregate Class and Source (pit number), use Agaregate Inspection Daily Report (Form
1900) or Material Source List (MSL) (Form 0501}.

Pavement Attributes - Chip Seal

: |Select Emulsion v ‘

*
Emulsion

¥ Emulsified Asphalt Supplier : [ select Emulsified Asphalt Supplier ~]

* .
Mumber of Courses : | | [Numeric Value]

Select New Aggregate Aggregate Summary
[ oyege [ Souee [W]

Empty - Add Aggregates

* Aggregate : |Select an Aggregate - ‘

-

Source

Add Aggregate

Add Aggregates | | Edit Aggregate | | Remove Aggregate

[ Back | [complete Layer| [Restore Defautts | | Cancel ]

[ Save Layer As Draft| [Add to Layers Library |

2) Select different layers that were previously added (within the same lane) by selecting a

layer from the layer drop-down list in the Layers Details pane to enter/edit attributes for

that layer.

3) Enter/edit the attributes for each layer. A description box is shown at the top of the Layer

Details screen, which includes the definition for each layer and where to locate layer

attributes using the construction-related documents. A comprehensive list of all layers and

their associated attributes can be found in the Data Entry Items available on the PHD

Informational website. Table 2-3 summarizes the main source for each attribute per

different layers.

@regates will be added.

&TE: If the Layer Details screen displays the Select New A
Summary panes, then select the aggregate used in the layer from the drop-down list. If
an aggregate is not shown in the drop-down list, select “Other Aggregate”, then enter the
aggregate name in the new text box (for example, ‘Man Sand’). Then, enter the associated
pit source number, and click on Add Aggregate.

NOTE: Aggregates in a completed layer can be added to another (draft) layer. In the
completed layer, click Add Aggregates in the Aggregate Summary box, then select the
aggregate(s) to add and select the draft layer(s) to add the selected aggregate(s) to. Note
that if the draft layer already contains aggregates, they will remain and the selected

regate or Aggreg%

4) Click Complete Layer to save layer details, if all the required attributes were entered. The

layer’s Data Entry Status (in the Lane Section pane) will be in a “Complete” status.

NOTE: If only some of the required attributes were entered, users can click Save Layer as
Draft to save the layer in a “Draft” status to complete to the layer at a later time. However,
the user cannot complete and save the lane details (as Complete) until all layers show a

“Complete” status.
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Copy Lane
Layers to
Shoulders

Save Lane
Details

Copy Lane
Details

Remove a
Lane

Lane layers (in a “Complete” status) can be copied to the shoulders if lane and shoulder layers
in a segment are identical or have similar layers/attributes. Any existing shoulder layers, of
the shoulder being copied to, will be overwritten when using the copy lane layers to shoulder
function. Follow the steps below to copy lane layers to shoulders:

| [savelane | Save Lane As Draﬂl | Cancel

| Copy Lane Layers to Shoulder(s) ||
|

[ Back
Back

1) In the Lane Summary screen, click Copy Lane
Layers to Shoulder(s) at the bottom of the

Which Shoulder side to copy layer to?

screen. WARNING: Selected side(s) existing shoulder layers

will be removed and replaced with copied layers

2) Select to copy to Both, Left, or Right shoulder.

Both Left Right Cancel

In the Lane Summary screen, click Save Lane to save the selected lane as Complete. A lane
can only be saved (as Complete) after all its details are entered and layers are in “Complete”
status. If Lane Details are incomplete (or only some layers were entered), users can click Save
Lane as Draft to save the lane in a “Draft” status and complete the entry later.

Lane details of a Complete lane can be copied to other lanes in “Draft” status. This can reduce
data entry and save users time if lanes are identical or have similar details/layers. All lane
information of the Draft lane(s) being copied to will be overwritten when using the copy lane
function. Follow the steps below to copy lane details:

3) In the Segment Overview screen, click

the Copy Lane button below the

Segment Details [ Job # - 208494 / PR # - 1175102 /MP : 0 ... 5.284 ] [ Show] A

O es
Segment Lanes pane. Select Lane Work Done : ‘;Lﬂ 1.0
4) Select the option to copy Lane Details [l oo Coo) oo R—
NOTE: Lalnes are always numbered right to left facing toward increasing milepoints of the PR
and/or Lane Layers of the lane. T e e e,
5) |n the completed Lanes [copv From] —Decreasmgg lane numbers C;, —fl,andg\ess are lanes right of Lane 1‘.
pane, select a Completed lane to copy [ —
. (W [sekectOption ]
from (only one lane can be copied from). Lene Detais
V] Lane Layers
6) Inthe Incomplete Lanes [Copy To] pane,
[ Tworchumver [ staws [ W[ ConeNumoer [ Staws ]
select the Draft (or incomplete) lane(s) [ it oo 0 et
to copy to (multiple lanes can be ‘ : |
Back Copy
selected to copy to). Then Click Copy.
In the Segment Lanes screen, select a lane
to be removed, and click Remove Lane.
Select Lane : Work Done : ‘(EES 1.0

Note that lanes can only be removed from
the outside. For example, if there are four
lanes: 1, 2, 3, and 4, lanes 2 and 3 cannot

Add Left Lane | [Add Rignt Lane | [Copy Lane| [Remove Lane

NOTE: Lanes are always numbered right to left facing toward increasing milepoints of the PR
segment:

- Lane 1 is the right-most travel lane of the PR segment.

- Increasing lane numbers 2, 3, and greater are lanes left of Lane 1.

- Decreasing lane numbers 0, -1, and less are lanes right of Lane 1.

be removed. The way to remove Lane 3 is to first remove Lane 4 and then remove Lane 3.

Alternatively, Lanes 1 and 2 could be removed and then remove Lane 3.

If work was done on Lane 4 but not Lane 3 (for example), do not use the Remove Lane option.

Instead, select “No” for “Work Done” in the Segment Lanes pane of Lane 3.
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4.2.2.2 Shoulder, Curb & Gutter Details

Shoulder
Details and
Layers

Curb & Gutter
Details

Save
Shoulder,
Curb & Gutter
Details

In the Segment Overview screen, click Shoulder, Curb & Gutter Details. The Shoulder, Curb
& Gutter Details screen will display, including the Left Side and Right Side tabs. Left and right
shoulders are established facing toward increasing milepoints in the PR segment (regardless
of traffic direction), as described in the Lane & Shoulder Numbering guidelines.

If shoulders are not automatically populated or incorrect, then the user needs to add or delete
them as needed. Use the following steps to add and/or edit Shoulder Details:

1) Choose either the Left or Right shoulder, and Click “Yes” for Work Done if work has been
done on the selected shoulder. Otherwise, click “No” to indicate no work has been done.

2) Select and enter shoulder details such as the Surface Type, Paved and Total Widths, if it
has corrugations (rumble strips), and if parking is present in the Shoulder Details pane.

NOTE: There are three possible different Width inputs for shoulders. The Total Width is th?
width of both paved shoulder and aggregate-based shoulder. The Paved Width is the width
of the paved shoulder only (in the current job). If the “Partial Width Paving” is selected, a
third option will appear “Partial Paving Width” which is the width of the paved shoulder
that was paved in this job (i.e., the remaining paved width is existing shoulder). )

3) Add layer(s) to the selected shoulder
side. To enter a new layer, select a
layer from the drop-down list, and

Left Side

¢ @ vyes C
@ ves

*
Work Done

¥
Has Corrugations(Rumble Strip) *

then click Add Layer. Users can also |, "t + Oves ® no
Partial Width Paving? O Yes @ po
select a layer from the Layers Library. | eevedwin N R |
. * Total width o R |
Please refer to the Layers Library 2;32#!2?( suts e . [P -
section for more information.

Layer : [Select a Layer

) I

Follow the steps outlined in Lane T > s 1o course ot O

. . 1 HMA Level Course Draft 0
Layers to add and edit layer details in

Layer : |Select a Layer v|

the selected shoulder.

In the Shoulder, Curb & Gutter Details screen
click “Yes” for Work Done if curb & gutter
work has been done on the selected shoulder,
and then select Curb Type.

Curb & Gutter Details [Job # - 208494 / PR # - 117510

® Yes Q Mo

+
Work Done +

’ Curb Type @ |Select Curb Type v

Select Curb Type
Asphalt Curb & Gutter
Concrete Curb & Gutter

Valley Concrete Curb & Gutter

In the Shoulder, Curb & Gutter Details screen, click Save Shoulder, Curb & Gutter to save the
selected shoulder (Left or Right) as “Complete”. A shoulder can only be saved (as Complete)
after all its details and layers are in “Complete” status. If shoulder details/layers are
incomplete (or only some layers were entered), users can click Save Shoulder as Draft to save

in a “Draft” status and complete the entry later.
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Copy Shoulder details of a Complete shoulder can be copied to another shoulder in “Draft” status.
Shoulder, This can reduce data entry and save users time if shoulders are identical or have similar
Curb & Gutter getails/layers. All shoulder information of the Draft shoulder(s) being copied to will be

Details overwritten when using the copy shoulder function. Follow the steps below to copy shoulder
details:
1) In the shoulder, Curb & Gutter Detai|S [ Back | | Save Shoulder, Curb & Gutter ] [ Cancel

screen, click the Copy Shoulder and/or Curb
& Gutter button.

2) Select option(s) to copy Shoulder Details,
Shoulder Layers, and/or Curb & Gutter

Copy Shoulder andlor Curb & Gutter || 5ave Shoulder As Draft|

Copy Options

(@ [selctopion |

Shoulder Details

Details. Shoulder Layers
3) Click Copy to Right/Left Shoulder. | Curb & Gutter Details
Back | |copy to Right Shoulder
4.2.2.3 Median Entry
Medians In the Segment Details screen, select the Median Type and enter Median Width, if applicable.

Median Type “Other” allows the user to enter a unique median type (not in the selectable list
of Median Types) in a new text box below. Review the Median Information section for more
information regarding Median Type and Width.

4.2.2.4 Segment Comments, Segment Summary, and Saving a Segment

Segment To detail additional information that cannot be entered in either the Lane Details or Shoulder,

Comments Curb & Gutter Details areas, use the Segment Comments box. For example, if the project has
a variable thickness for the subbase layer, users can use the average or the predominant
thicknesses (in the Layer Details), and insert a Segment Comment to indicate that the
thickness is variable (or within a specific range).

Segment To view a summary of segment-level information for the currently active segment, users can

Summary click Segment Summary. The summary is in PDF format and can be saved or printed.
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Save In the Segment Overview screen, and

Segment after completing all the Lanes and |FEFEit = nep [ iokdone ] St
Details Shoulder, Curb & Gutter Details within | BN corpere  compiste 22 comeles

the segment, click Save Segment to | T

[WorkDone [
save the selected segment as

‘Shoulder, Curb & Gutter Details ]

“Complete”. ‘

A segment can only be saved (as | wedanmie : [Undvided ~]

Complete) after all its Lanes and
Shoulder, Curb & Gutter Details are in | Fersi Gommers

[max 250 characters]

“Complete” status. If not, users can
CI|Ck Save Segment as Draft tO save the ( Back |J[ save Segment| [ Save Segment As Draft| | Segment Summary |f Cancel
segment in a “Draft” status and complete the entry later.

After saving the segment,

PR Segment List [Hide ] ¥

Data
Status

Framework

users can return to the PR | ERAES I e
Segment |.iSt (that displays a @ 1 1270708 23 0 0.422 Greenland Rd Active Complete
O 2 1270708 23 0.422 0.513 M-38 2 Way Active Complete
list of all road segments in ) 3 1270708 23 0.513  13.237  M-38 2Way  Active Draft
the Selected job) to Continue O 4 1270708 23 13.237 13.305 M-38 2 Way Active Draft
[ SegmentDetails | [ Copy Segment Details | [Create Segment| [Delete Segment(s) | [View Map|

working on other segments.
The Data status in the PR

Segment List will indicate a “Complete” status for each segment saved with complete Lanes,

Shoulder, and Median Details. The job cannot be finalized until all segments show a
“Complete” status.

4.2.3 Copy Segment Details

Copy Segment details of a Complete segment can be copied to other segment(s) in “Draft” status.
Segment This can reduce data entry and save users time if segments are identical or have similar
Details details. All segment information of the Draft segment(s) being copied to will be overwritten
when using the copy segment
function. Follow the steps below e e Paioe | D5
Number Status Status
H P @ 1 1270708 23 1] 0.422 Greenland Rd Active Complete
to COpy Segment dEtaIIS' O 2 1270708 23 0.422 0.513 M-38 2 Way Active Complete
. O 3 1270708 23 0.513 13.237 M-38 2 Way Active Draft
1) In the Road Segment List O 4 1270708 23 13.237 13.305  M-38 2way  Active Draft
SCI‘een, and under PR Se ment |L seng:nm:jnsr !\ Copy Segment Details || Create Segment| |Delete segmentis) | | View Map|
FRoegment (o o
List pane, click Copy Segment
Details button. | | # | sumber [PRt9] WP | Ewp | Roue | Diecton | FREROR | S, |
O 1 1270204 22 5.519 6.569 M-26 2 Way Active Complete
2) Selecta Completed Segment to ® 2 1270204 22 6569  6.652  M-26 2way  Active Complete
. . O 3 1270204 22 6.652 6.696 M-26 2 Way Active Draft
copy Its detalls, and the O 4 1270204 22 6.696  7.660  M-26 2 Way Active Draft
Incomplete Segment(s) to copy
PR N . Framework Data
the detals to (muliple | IIIESCOR R Tl -
3 1270204 22 £6.652 0.696 M-26 2 Way Active Draft
Segments Can be copied to) 4 1270204 22 6.695 7.669 M-26 2 Way Active Draft
3) Click Copy Details.




4.2.4 Project Comments, Project Summary, and Saving/Finalizing a Job

Project To detail additional information that cannot be entered in the Segment Overview screen, use

Comments the Project Comments box. These comments can capture project-level information that is not
specific to a segment.

Project To view a summary of project-level information (including all entered segments and their

Summary lanes, shoulders, medians, and layers), users can click Project Summary. The summary is in

PDF format and can be saved or printed.

Save/Finalize In the Road Segment List screen, after completing all the segment details, click Finalize Job
a Job to finalize the job and send it to the PHD Data Owner for review and approval. An automated
E-mail notification is sent to Data Owners (within the Region of that user’s assigned location)

when a Data Entry user submits a job for review.

NOTE: Once finalized, the job cannot be seen or edited by the Data Entry user unless later
the job is saved as a draft by a Data Owner and reassigned back to the Data Entry user.

A project can only be finalized after all its segments are in “Complete” status. If not, users can
click Save Job as Draft and complete the entry later. To continue entry in this job in the future,
use the Modify submenu in the left navigation bar and select the job.

NOTE 1: If the user is a Data Owner, accessing the job in the Review submenu and saving
it as a “Draft” will move it to that Owner’s Modify submenu.
NOTE 2: Once finalized by the Data Owner, the job cannot be accessed for editing, unless

a PHD Administrator unlocks the finalized job, and reassign it to the Data Owner or Data
Entry user.
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4.2.5 Layers Library

Layers
Library
Overview

Layers (in a “Complete” or “Draft” status) can be saved in the Layers Library list (formerly
known as Quick Layers), and later can be applied throughout the same job (into different
lanes and shoulders) or a different job assigned to the same user. This can reduce data entry

and save wusers time when a layer and its attributes apply in different
segments/lanes/shoulders throughout the same or different job.

There are two methods to create/add layers to the Layers Library list and apply those layers
to different segments, lanes, and/or shoulders within the same job: (1) from the Layer Details

and Lane Summary screens, and (2) from the Layers Library Overview screen within the Road

Segment List screen. Layers can also be created (but not applied to different segments, lanes,
or shoulders) through the Layers Library submenu. The Layers Library submenu is where all
layers are saved, to be used across different jobs (assigned to the same user).

4.2.5.1 Creating/Adding Layers to the Layers Library list

(1) Adding from

Layer Details
Screen

(2) Adding from
Layers Library
Overview
Screen

Layers can be added to the Layers Library list “on the fly” as they are created in the Layer
Details screen. Follow the steps below:

1) Inthe Lane Summary screen and under the Lane Section pane, select a created layer to be
added to the Layers Library list.

2) Click Add to Layers Library and enter a

unique User Specified Name (for user

* Cold Milling Depth |2 v |in
reference —no required conventions). ONce | * <. witing Texture : |Fine <]
added, the layer will be shown in the Layers | * cold miling ype ~ © [Profile Milling v]

Library Overview screen within the Road [

Back ] [Complete Layer\ [Restore Defaults] [ Cancel ]

Segment List screen, and also shown in the | e teveras oran | ade to ayers ioar |
Layers Library submenu.

Layers can be created/added to the Layers Library list (and modified) from the Layers Library
Overview screen within the Road Segment List screen. Follow the steps below:

1) In the Road Segment List screen, click Layers Library Overview.

2) Under the Create/Modify Layers tab, select a new layer |

Create/Modify Layer(s) Add Layer(s)

from the drop-down menu, and enter a User Specified
Name in the text box. There is no technical convention for Laver

User

this name. Users are encouraged to enter an easily spectted : [ |
recognizable name.

3) Click Add Layer, and the added layer will be displayed in the Layers List pane to the right
of the Select New Layer pane. Data Entry Status is “Draft”.
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4) In the Pavement Attributes
pane, select or enter each

|| Creae/Modiify Layer(s) ™ [AaNSNENE) _——

material attribute. tover [selectataver v Hn
. ecified : Hame
5) Click Save Layer, and the Data Name 1 Cold Miling Millng Complete )

Add Layer |

| Remove

Entry Status of the layer in the
Layers List pane will be saved as
“Complete” (if all required

Pavement Attributes - Cold Milling

User Specified Name  : |Milling

*
Cold Milling Depth 0.88

. * Cold Milling Texture : [Fine hd
inputs for the lane are entered) e e Trevng .
or “Draft” (if some required [ e o

inputs for the lane are missing). |

6) Repeat Steps 2 — 5 to create additional layers. All layers will be displayed in the Layers List
pane. Be sure to click Save Layer after changes are made.

7) To modify a layer, select the layer from the Layers Lists pane, and edit the layer User
Specified Name and/or attributes.

8) Once all desired layers have been created, edited, and saved, click Save at the bottom of
the screen. Note that each layer needs to be saved, and the page itself needs to be saved

to ensure that all layers are fully saved. Clicking Back will return to the Road Segment List

screen and all entered layers will be lost.

3) Addin_g from  Layers can be created/added to the Layers Library list (and modified) from the Layers Library
;—S\W submenu, under the Post Construction Data menu from the Navigation Panel on the left side
of the main PHD window. This menu is independent of any job for the same user. Follow the

same steps described in Adding from Layers Library Overview Screen.

4.2.5.2 Applying/Adding Layers from the Layers Library list

(1) From Lane Layers saved in the Layers Library list (in a “Complete status) can be added to any Lane and/or
Summary Shoulder. Follow the steps below:
Screen _ "

1) In the Lane Summary screen, and under the Select |« "™ *=*** S werkpene o

Add Left Lane  Add RightLane | | Copy Lane | |Remove Lane

a Layer from the Layers Library, select a layer from |

the drop-down menu. These are the same layers :pii!;i.fif;s o e

. . . . . section)

listed in the Layers Library list that are in |

“Complete status. * Lane Type ¢ [Mainiine -

N
Width 12 vt

. . * v : 2023 [ 1
2) Click Add Layer. The layer will be shown under the |, ™" WW
9"1‘“ it : Oves @po
Lane Section pane. i
L
3) Click Save Lane (if all required inputs for the lane |E3 Layer Name =0
are entered) or Save Lane as Draft (if some | i op Course complete 1
| Move Up | | Move Down | | Remove
required inputs for the lane are missing).
Layer : [Select a Layer ~
Add Layer
[Seecta Loyer from the Loyers Loy ||
Layer : |Select a Layer ~
HMA Top Course (Top_85541) | Addiayer |

HMA Level Course (Level_85541)
Cold Milling (Milling)

i

Copy Lane Layers to Shoulder(s)
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(2) From Layers
Library Overview

Screen

Follow the steps below to apply/add layer(s) saved in the Layers Library list to any Lanes
and/or Shoulder, within any Segment, in the current job. Follow the steps below:

1) In the Road Segment List screen, click Layers Library Overview.

2) Click the Add Layer(s) tab, then click “OK” for the warning message to ensure all entered

layer data is saved before navigating away from the screen.

E Create/Modify Layer(s) Add Layer(s)

Select New Layer Layers List

Layer H ‘ Select a Layer

User

Name

T A 2

d =]
Name
3 HMA Top Course Top_85541 Complete O
HMA Level Course Level 85541 Complete O
1 Cold Milling Milling Complete O

3) In the PR_Segment List pane, select the segment that contains the lane(s) and/or

4)

5)

6)

7)

shoulder(s) to add layer(s) to.

In the Lanes and Shoulders pane,
the lane(s) and/or
shoulder(s) to add layer(s) to.
Multiple
shoulder(s) can be selected.
Clicking on each individual Lane
Shoulder display the
existing layers in the selected
the
Lane/Shoulders Section pane.

In the Layers List pane, select a
layer or more to apply to the

select

lane(s) and/or

or will

lane or shoulder in

selected lane(s) and/or

shoulder(s) (from step 4), then

L e IERVERER] Add Layer(s) —

| # | e P oe | e | rone Jorecion] ™| g |
Number Status Status
O 1 1270708 23 ] 0.422 Greenland Rd Active Complete
22020822 S T 2aia Al c

I ® 3 1270708 23 0.513 13.237 M-38
QO 4 1270708 23 13.237 13.305 M-S-B

Lanes and Shoulders

Lane

2422

2 way
—
2 Way

Draft
Draft

Active

Active

Lane

Shoulder

O
]
B

Shoulder

Layers List
Data Entry
(& Leereme | POR S
(m] gecdl Comalat

L oo O L

I 7l HMA Level Course

— lema T T

Level_85541 Complete I

T

Back [ save |

click Add Library Layer (located above the Layers List pane) to apply the selected layer(s).

Click Save.

Repeat Steps 3 — 6 to add more layers to lane(s) and/or shoulder(s) in other segments.

Note that users need to continuously click Save after adding layers(s) to lane(s) and/or

shoulder(s) within a segment, before moving to the other segment.
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4.2.6 View Map

View Map
Function

The View Map function is an alternative way to create, modify, and remove segments. Instead
of showing all the job segments in Road Segment List, segments can be visually displayed on
a map and added by clicking without needing to know or search PR numbers for roadways.

In the Road Segment List screen, click View Map to enter the map. The map screen will

appear, with a list of segments at the bottom of the screen (PR Segment List) that are
highlighted in blue on the routes on the map. If a segment is selected from the PR Segment
List, the selected segment is highlighted in green, and the remaining segments are still
highlighted in blue. The map can be displayed in three different view types: Street, Aerial, and

Hybrid. At the top of the map screen, select the Radio button for the desired view type.

I @ Street O Aerial

H;

ybrid

brint || Add Segment || Legend

: 3

\\\\\

PR Number
1270204
2 1270204
31270204

4 1270204

[ Back | [ save

PR(V)

5.519

6.569

6.65

2

6.696

BMP

6.569

6.652

7.669

EMP

M26
M26
M-26

M26

2 Way
2 Way
2 Way

2 Way

Active
Active
Active

Active

irection Framework Status

Data Status
Draft
Draft
Draft

Draft

Add
Segments

1) Click Add Segment in the View Map screen.

Follow the steps below to add a segment in View Map:

2) Click on a road within the map to add a point. The entire length of the selected PR will be

highlighted in blue and will be added to the segment list at the bottom of the screen.

3) Click Save to save changes, or Back to undo.

® Street O Aerial © Hybrid F‘nml Add Segment Iegend

PR Number
2 1270204
3 1270204
4 1270204

5 1270906

6.569

6.652

6.696

BMP

6.652

7.669

EMP

Route

Direction

2 way
2 way
2 way

2 way

Framework Status
Active
Active
Active

Active

Data Status
Draft
Draft
Draft

Draft
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Change Follow the steps below to change segment milepoints in View Map:

ment
Segme 1) Select a segment, either by clicking on a segment from the map or by selecting a segment

Milepoints . .
P from the PR Segment List at the bottom of the screen. The Road Segment Information
box will appear.

2) Click Edit and change the BMP and/or EMP. Note that the minimum BMP and maximum
EMP for the PR are shown in parentheses to the right. Entered milepoint values cannot go
outside these boundaries.

3) Click Save to save changes.

® Street O Aerial O Hybrid | Print | [ Add Segment | [ Legend |
/ Road Segment Information o x
i @ [ ] PR NUM 1270906
= = smp 0 (0)
EMp 5.923 (5.923)
=D =3
PR Number PR(V) BMP EMP Route Direction Framework Status Data Status
2 1270204 22 6.569 6.652 M-26 2 Way Active Draft -
4 1270204 22 6.696 7.689 M-26 2 Way Active Draft
Page 1 of 1 View 1 -5 0f 5
[Baot | Come |
Delete Follow the steps below to delete a segment in View Map:
Segments ) o )

1) Select a segment, either by clicking on a segment from the map or by selecting a segment
from the PR Segment List at the bottom of the screen. The Road Segment Information
box will appear.

2) Click Delete.

3) Click Save to save changes.

Saving or Users should always click on Save after changing the segment milepoint or after deleting a

_Und_O Changes  segment. Clicking on Back will return to the Road Segment List screen, and any changes made
in View Map

will not be saved.
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Chapter 5. Simplified CPM Format Jobs

5.1 Simplified CPM Jobs in PHD

Simplified
CPM
Information

Jobs that have Work Type Codes from 400 to 499 are Capital Preventative Maintenance
(CPM) type jobs, such as Asphalt Crack Treatments, Sealing Concrete Joints, and others. Data
entry for these types of jobs can be relatively time-consuming due to the CPM variety of fixes
and various locations. To streamline and reduce the data entry needs for CPM jobs, users can
select the Simplified CPM format option at job creation (for JobNet and Non JobNet jobs).

(NOTE: The Simplified CPM format: \

» Requires segment layer information only.

> Does not require segmentation (dividing into several subsegments) based on lane or
shoulder changes.

> Does not allow entry of lanes and their details.

> Does not allow entry of shoulder details (still requires shoulder layer(s)/work item(s)).

Q Does not allow entry of median information. )

(NOTE: The Simplified CPM format should not be used: A

> in projects where lanes have different paved or placed work.
> In projects involving HMA paving (like one course HMA paving) since PHD will not be able

\ o calculate the total HMA tonnage when the Simplified CPM format is used. y

Creating, modifying, and finalizing Simplified CPM format jobs is very similar to the standard
jobs. Refer to Chapter 4 for more details. Chapter 5 will briefly discuss CPM format jobs’ data
entry process, and will highlight the differences with the standard jobs entry.

5.2 Create Simplified CPM Jobs

Create
Simplified
CPM Jobs

Follow the steps below to create Simplified CPM Jobs (JobNet or Non JobNet Jobs):

1) Click Create from the Post Construction Data menu (in the left navigation bar).
2) Select “Yes” or “No” for JobNet Job or Non JobNet Job.
3) Enter the JobNet Job ID or the Non [obporase ————————————————

Non JobNet Job ID : M208785

JobNet Job ID (follow the guidelines | "on sobet 10b Tvpe ¢ [Maintenance " Funded ~]

. N . Work Type Code H \456 - Asphalt Crack Treatment v
listed in Table 2-2 for the Non |- . : Vear(s) Fix Lfe Gulde
. . *
Use SIMPLIFIED CPM ft t for dat -

JObNet Namlng Convent|0n). entri?? [only use when a\‘ljrll:naes g;da\w?:rk ¢ @ves Ono

is the same]
4) Click Next Step, and fill out/select O)cpm Emerging Technology Funded

Special Project Type . [) pemonstration Project

the required fields in the Job Details | =" vree o weesl U National Pavement Studies

- L State Pavement Studies

screen. * Open to Traffic Date

[This is the date wh Il
“ ” . . to tlrfe‘suubfic ?r;f‘f\\y(.eFI:)ram;:ii;T open . EEv| tmm/dd/yyyy]
jects, pl timate it f; w and

> Select “Yes” for Use Simplified | s pree eeimate tforrov o0

change it later.]
CPM Format.

[ Back | | save & Next| | Cancel

> If  applicable, select the
appropriate Special Project Type.
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GOTE 1: To qualify as a Special Project, the job needs to be one of the following: (1))
Pavement Demonstration Program project, (2) a CPM Emerging Technology Program
project, (3) a state pavement study [must include a study number], and (4) a federal
pavement study [must include a study number].

NOTE 2: Open to Traffic Date is the date when all lanes are open to the public traffic. For
multi-year projects, please estimate it for now and use a placeholder to come back and

Qange it later. j

5) Click Save & Next to continue. If this is a JobNet Job, the Road Segment List screen opens

and displays a list of all road segments (in the PR Segment List tab). If a Non JobNet job,

the Road Segment List screen will not be populated with road segments, and users need

to create each segment.

NOTE: After the Simplified CPM format job is created, it will remain in the selected CPM
format and cannot be changed later. If the incorrect format is selected in error, contact
the PHD Administrator to delete the job and begin again.

5.3 Modify Simplified CPM Jobs

Modify Similar to standard format jobs, once a Simplified CPM format job has been created, it can

Simplified be later edited/modified (1) immediately after the PHD job is created from the Create

CPM Jobs submenu, or (2) by selecting a previously created job from the Modify submenu.

Road Similar to standard format jobs, the

Segment PR Segment List (within the Road

List Segment List) displavs a list of all road
segment List) displays a lst | || # | e [Peta] owe | e | Roue Jowecton] P | 20 |
Segments in the selected JOb Users @ 1 o804 22 0 3 us-127 Ne Active Draft

. E:? 2 349804 22 3 3.2 us-127 NB Active Draft

can enter Segment Details, Create | - . s = o NB  Active Dratt
Segments, Delete Segments, and |- : ZI0 L 5 LT L ke e o
copy segment Detai|S from one | segmentDetsils | [ Copy SegmentDetzils | [ Greate Segment| |Delete | [ViewMzp |
segment to another. Users can also

Change the PR Segment Mile Points BT T CT I | «.c. o sub scoments : [ | [Atleast 2]
13404 [ o[ 3
for any segment, and can Create Sub

Segments (i.e., dividing the segment

Project
Comments

into two or more subsegments). Refer | (mex 250

characters] Yy

to the f0||OWiI’1g SeCtiOnS in Chapter 4 [ Back | [Finalize Job| [ Save Job as Draft | | Cancel |
for more details: Create Segments, Frakeet furmey

Change Segment Milepoints, Create PR Sub Segments, and Delete Segments.
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5.3.1 Edit Segment Details

Segment
Details

5.3.1.1 Segment Layers and Year Paved/Placed

Select the radio button of a segment from
the PR _Segment List pane, then click

Segment Details. The Segment Overview |[ZEIZEENEN v-s Yes

screen displays and users can:

> Add Segment Layers, including the |[Ems

Segment Details [ Job # - TEE/ PR # - 405903/ MP : 0 ... 0.461] [Show] A
Segmert houearOvarview
T e
Layer Name Status

T o o
Segment Curb & Gutter Overview T
I

Layer : [Select a Layer v
[ Shoulder, Curb & Gutter Details ] Select a Layer from the Layers Library

year in which they were Paved/Placed
(see section 5.3.1.1).

*
Year [Paved/Placed]

Layer : [select a Layer

S Jvem

Add Layer

» Click Shoulder, Curb & Gutter Details
to define shoulders or curb & gutter

Segment Comments
[max 250 characters]

N I<

| [Save Segment] [ Save Segment As Draft] [ Segment Summary | | Cancel

(see section 5.3.1.2).

1o Shoulder(s]

> Enter segment comments in the Segment Comments box (see section 5.3.1.3).

NOTE: Unlike the standard format, the Simplified CPM Segment Overview screen does not
have a Lane Details button, as individual lane details are not entered for Simplified CPM
projects. Similarly, the Simplified CPM Segment Overview screen does not have the

Median information box.

Segment
Layer(s)

In the Segment Overview screen, the Segment
Sections pane displays the layers and layer
status (Draft or Complete) for the selected
segment. Layers can be created, imported from

Layers Library, re-ordered, or removed in this
pane. Layer details can be added or edited after
a layer is created or selected from the pane,
similar to standard format jobs. Refer to Lane
Layer(s) in Chapter 4 for more details.

Users need to enter the year in which the layers
were paved/placed. The segment can be saved
anytime by clicking Save Segment as Draft. Once
all the layers in a segment are in “Complete”
status, the segment can be saved as Complete by
clicking Save Segment.

‘ \.

Segment Sections

Data Entry
o[ o [PE ]

Conc Pavt Repairs (Full
Depth) Draft O

1

| Move Up| |Move Down | | Remove|

Select New Layer

Layer 2 |Conc Pavt Repairs (Full Depth) V|

Add Layer

Select a Layer from the Layers Library

Layer 2 |Se|ect a Layer V|

Add Layer

" Year [Paved/Placed] : [yyyyl

4

o



5.3.1.2 Shoulder, Curb & Gutter Details

Shoulder
Layers

Save
Shoulder,
Curb & Gutter
Details

Copy
Shoulder,
Curb & Gutter
Details

In the Segment Overview screen, click
Shoulder, Curb & Gutter Details. The

Left Side

Shoulder Details [ Job # - TEE / PR # - 405903/ MP :0 ... 0.461] Left Side

*
Work Dane ¢ @ ves O no

Shoulder, Curb & Gutter Details screen
H H H H H er : | Select a Layer v er Name Data Entry
will display, including the Left Side and | (st | I -
] ) ) Add Layer 1 giy;éh?)avt Repairs (Full Draft 0
Right Side tabs. Left and right shoulders e

are established facing toward increasing [ == @ s=etor ]

m||ep0|nt5 in the PR segment (regard]ess Curb & Gutter Details [Job # - TEE / PR # - 405303/ MP :0 _.. 0.461 ] Left Side
of traffic direction), as described in the [ "o’ O ©w

Lane & Shoulder Numbering guidelines.  |——ss—  seowamansomm ) [ cue

( Copy Shoulder andior Curb & Gutter |[save Shoulder As Dratt|

Shoulder details that are required for standard format jobs are not shown because these
details are not needed for Simplified CPM format jobs. Only shoulder layers are needed for
the Simplified CPM format. Layers can be added or edited after a Layer is created or selected
from the pane, similar to standard format jobs.

The Curb & Gutter Details pane is the same for Simplified CPM and standard format jobs.

In the Shoulder, Curb & Gutter Details screen, click Shoulder, Curb & Gutter to save the
selected shoulder (Left or Right) as Complete. A shoulder can only be saved (as Complete)
after all its layers are in “Complete” status. If shoulder layers are incomplete (or only some
layers were entered), users can click Save Shoulder as Draft to save in “Draft” status and
complete the entry later.

Shoulder layers of a Complete shoulder can be copied to another shoulder in “Draft” status.
This can reduce data entry and save users time if shoulder layers are identical or have similar
layers. All shoulder layers of the Draft shoulder(s) being copied to will be overwritten when
using the copy shoulder function. Follow the steps below to copy shoulder details:

1) In the Shoulder, Curb & Gutter Detai|S [ Biack | Save Shoulder, Curb & Gutter J | Cancel
screen, click the Copy Shoulder, Curb &

Gutter button. i
2) Select option(s) to copy Shoulder Layers, | | gy

and/or Curb & Gutter Details. Shoulder Layers
3) Click Copy to Right/Left Shoulder. Curb & Gutter Details

Copy Shoulder and/or Curb & Gutter Save Shoulder As Draft

| Back | [copy to Right Shoulder
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5.3.1.3 Segment Comments, Segment Summary, and Saving a Segment

Segment
Comments
and Segment
Summary

Save
Segment
Details

Similar to standard format jobs, users can use the Segment Comments box to detail additional
information that cannot be entered in either the Segment Layers or Shoulder, Curb & Gutter
Details areas. Similarly, users can click Segment Summary to view a summary of
segment-level information for the currently active segment.

Similar to standard format jobs, a

[t o] Doy
Status
Yes
3

segment can only be saved (as

Yes
Concrete Penetrating Sealer Cemplete O

Complete) after all its Layers and : ,  Conc Pavt Crackioint
Segment Curb & Gutter Overview Sealing

Shoulder, Curb & Gutter Details are ECIMNTIR * o Growe O

Complete Complete
Complete 0

in “Complete” status. If not, users

[SelectNewlayer |

. I Shoulder, Curb & Gutter Details. ]
can click Save Segment as Draft to tayer : [Select a Layer v
save the segment in “Draft” status | verievesraces < [ 20220
and complete the entry later. Layer : [Select a Layer v

Segment Comments
[max 250 characters]

Save Segment | [ Save Segment As Draft| [Segment Summary

Copy Segment Layers to Shoulder(s)

After saving the segment, users can return

PR Segment List [Hide 1¥

. . . PR _ ramework | Data
to the PR Segment List to continue working | HEH IS VRN REN B
@ 1t 349804 22 0 3 Us-127 NB Active Complete
on other segments. The Data status in the |02 sses 2 5 52 wsar w seve fonn
() 3 3ess0 2 O 4555 us-127 NE Active Draft
PR Segment LiSt W|” indicate a ”Complete” () a4 368910 22  4.555  8.235  US-127 NE Active Draft
[ SegmentDetsils | [ Copy SegmentDetails | [Create Segment| [Delste | [ViewMzp

status for each segment saved with [e=tome

complete Layers and Shoulder Details. The job cannot be finalized until all segments show a
“Complete” status.

5.3.2 Copy Segment Details

Copy
Segment
Details

Similar to standard format jobs, segment details of a Complete segment can be copied to
other segment(s) in “Draft” status. This can reduce data entry and save users time if segments
are identical or have similar details. All segment information of the Draft segment(s) being
copied to will be overwritten when using the copy segment function. Refer to Copy Segment
Details in Chapter 4 for more details.

5.3.3 Layers Library

Layers
Library
Overview

Similar to standard format jobs, layers (in a “Complete” or “Draft” status) can be saved n the
Layers Library list (formerly known as Quick Layers), and later can be applied throughout the
same job (into different segments and shoulders) or a different job assigned to the same user.
This can reduce data entry and save users time when a layer and its details apply in different
segments and/or shoulders throughout the same, or different, job. Refer to the Layers Library
section in Chapter 4 for more details.
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5.3.4 Project Comments, Project Summary, and Saving/Finalizing a Job

Project
Comments
and Project
Summary

Save/Finalize
a Job

Similar to standard format jobs, users can use the Project Comments box to detail additional
information that cannot be entered in the Segment Overview screen. Similarly, users can click

Project Summary to view a summary of project-level information (including all entered
segments and their layers).

Similar to standard format jobs, and after completing all the segment details, click Finalize
Job (in the Road Segment List screen) to finalize the job and sending it to the PHD Data Owner

for review and approval. An automated E-mail notification is sent to Data Owners (within the
Region of that user’s assigned location) when a Data Entry user submits a job for review.

\
NOTE: Once finalized, the job cannot be seen or edited by the Data Entry user unless later
the job is saved as a “Draft” by a Data Owner and reassigned back to the Data Entry user.

v

A project can only be finalized after all its segments are in “Complete” status. If not, users can
click Save Job as Draft and complete the entry later. To continue entry in this job in the future,
use the Modify submenu in the left navigation bar and select the job.

NOTE 1: If the user is a Data Owner, accessing the job in the Review submenu and saving
it as a “Draft” will move it to that Owner’s Modify submenu.

NOTE 2: Once finalized by the Data Owner, the job cannot be accessed for editing, unless
a PHD Administrator unlock the finalized job, and reassign it to the Data Owner or Data
Entry user.
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Chapter 6. Review and Reassign

6.1 Introduction

PHD

Quality
Assurance

Quality assurance is a critical step to ensure proper and complete data entry. Therefore, a
Review stage is integrated into PHD, where jobs submitted by Data Entry users are reviewed
by Data Owner users. Once a Data Entry user submits a job for review (by selecting the
Finalize Job button), the job will be relocated to the Review submenu, and the Review stage
can begin.

Jobs in the Review submenu are only visible to Data Owner users (jobs within their
Assignment Location jurisdiction). Jobs in the Review submenu will look and operate the
same as Draft jobs from the Modify submenu.

NOTE: E-mail notifications are sent to all Data Owner users (within the Region of a specific
Assignment Location jurisdiction) when a Data Entry user from that jurisdiction submits a
job for review. Data Owner users must have active communication with Data Entry users
and should regularly check the list of jobs in the Review List screen for new jobs ready for
review.

6.2 Data Review Process

Review
Submenu

Data Owners can select the Review submenu from the Post Construction Data menu to locate

jobs that were finalized by Data Entry users and are ready for review.

The Review List screen will display JobNet and Non JobNet jobs available for review, that are
within the Data Owner user Assignment Location jurisdiction. A sample Review List screen is
shown below.

Data Owner users are responsible for job review, editing and/or reassignment, and finalizing.

 :: Post Construction Data | Review List Role[s] :: Data Owner, System Administrator
- Post Constr. Data
o Create Search Filter [Hide ] V¥
»  Modify Job Type : O JobNetob O NonJobNetJob @ Both

o Review Work Type [ Any v

»  Reassign JobNet Job Details Non JobNet Job Details
ELCU SR dobNet dob [T )| Non Jobet Job Id
Id :

Non JobNet Job Type  : [Any v

+ Administration

Apply Filter| [Reset Filter

JobNet Job Non JobNet

130008 160—Reconstruction PolingS2

408—Milling & One Course Asphalt
Overlay
684—Milling and Two Course

210084 — — Asphalt Resurfacing ledentm0122

208614 = = JohnsonD5191

Page: 1 of 1

Oefl] 1 ][
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6.2.1 Data Review

Data Review
Tips

Data Owners should review all segments, lanes and shoulders, layers, and their attributies in
a job. Project Summary and Segment Summary reports are very helpful to to view a summary

of project and segment-level information for a job. Common entry errors to look for include:

1) Incorrect project PR numbers and milepoints.
2) Segments input in the wrong direction. Please review the Segmentation Rules for more

details.
3) Over and/or under-segmentation. Please reviewthe Segmentation Rules for more details.

4) Omitted and/or missing items:
= Missing segment(s), such as ramps.
= Missing layer and/or work items, such as scratch (wedging) course, ASCRL mix, etc.
= Missing lanes, shoulder, or curb & gutter.
= Missing non-required layer attributes that are known/obtainable.
= Missing aggregates from a mix design.
= Missing warm mix designation.

5) Incorrect layer inputs, such as layers in the wrong order (upside down), and
extra/duplicated layers. Please review Lane & Shoulder Layers for more details.

6) Incorrect lane numbering, such as lane 1 is not designated as a mainline lane, or lanes 0, -
1, etc., are designated as mainline lanes. Please review Lane & Shoulder Numbering for
more details.

7) Incorrect Lane/Shoulder, Curb & Gutter information, such as Surface Type (please review
Examples of Lane Surface Types), Lane/shoulder Widths, and Lane Type.

8) Common copying errors, such as copying lane details to the incorrect lane number.

6.2.2 Data Edit and Reassignment

Edit or
Reassignment
Process

If errors or missing data are identified during job review, Data Owner users have two options:

» Make the appropriate edits to the job, or
» Send the job back to the Data Entry user to make edits to the job. Use the following steps:

1) Click on Save Job As Draft (in the job Road Segment List screen) to send the job back to
“Draft” Status. The job will appear in the Data Owner user’s list of jobs in the Modify
submenu.

2) Use the Reassign submenu to assign it to the Data Entry user for edit. In the Reassign
submenu, and under the ‘Assign To’ column header, select the new user from the drop-
down list, then click Update. Multiple jobs can be reassigned simultaneously (for the
same or different users).

NOTE: Automated notifications are not sent when a job is reassigned. Data Owner users
must directly notify the user that they have reassigned a job to.
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4:: Post Construction Data | Reassign List Role[s] :: Data Owner , System Administrator
- Post Constr. Data

»  Create
»  Modify Job Type : O JobNetJob ) Non JobNet Job @ Both
S e Work Type . [any v
T
ports & Searche JobNetJobID  : % Non JobNet Job ID :
Non JobNet Job Type : [Any v]

Apply Filter| [ResetFilter

JobNet Job ID A |Non JobNet Job 1D [Non JobNet Job Type | Work Type E B

160— Hamlin
33799 Reconstruction Alison Select User z
213—
_ _ Interchange  Loree
37795 Redesign & - Select User- v
Upgrading
45790 _ _ 164—Asphalt  Loehle .

Reconstruction William

6.2.3 Finalizing a Job

When a job is complete and reviewed for possible errors and/or data omissions, Data Owner
users should finalize the job by clicking on Finalize Job (in the job Road Segment List screen).
The job is submitted as a finalized job in the PHD database and its associated segments and
their data can be searched for in the Reports & Searches menu.

NOTE: Once a job is finalized in the database, the job cannot be accessed for edit unless a
request is made to the PHD Administrator to unlock the job.

6.3 Data Review Resources

The PHD Review Checklist document available on the PHD informational website can be used
as a guide in the Data Owner’s review process. A list of data that should be entered in PHD,
the Data Entry Items in PHD document, can also be used.

6.4 Central Office Quality Assurance Process

In addition to the Data Review process by Data Owners, PHD Administrators also perform a
QA process, which consists of two parts.

Part 1 checks for “Completeness”. l.e., check if all pavement jobs (for the specific construction
season) were entered. The PHD database is compared to the JobNet Database and other
MDOT databases, and if discrepancies are found, PHD Administrators will contact the
TSC/Region to enter/complete the missing jobs.

Part 2 checks for “Accuracy”. l.e., checks if PHD jobs were entered correctly. Randomly
sampled PHD jobs (for each Region) are selected for additional review, and PHD data is
compared to construction records. Possible errors are sent to the Data Entry and Data Owner
users to verify/correct the entered PHD data.
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Chapter 7. PHD Reports and Searches

7.1 Introduction

As mentioned in Chapter 1, PHD is designed to store “As Built” pavement typical section
information and materials data on Michigan’s state-owned roads (trunkline). The Reports &
Searches menu is available to transpose stored data into the form of different exports and
reports. Therefore, project data can be quickly and easily searched, sorted, and exported,

without the need to review each project’s plans, proposal, contract
- Reports & Searches

modifications, and other construction-related documents. These Coort Dot
» Export Data
exports and reports can be used to improve pavement management
. . . . » Search Segment(s)
systems by analysis of output trends, quantities, or historical records, o
» Construction History

and can also aid scoping, sufficiency, and estimating. The complete list
of PHD uses is available in Chapter 1 (PHD Purpose and Uses).

» Material Information

» Material Quantity
After Data Owner users have finalized jobs, their segment data can be » Network Inventory

searched and output in report form using the Reports & Searches » Work Type

menu. All PHD users have access to this menu. » MAP Reconciliation

7.2 Export Data Submenu

Export Filter
and Details

The Export Data submenu allows users to search for existing pavement segments and
provides an external output Excel file (CVS format) for saving and data processing.

The Export Data submenu includes the Export Filter and the Export Data Details pane. In the
Export Filter pane, output data can be filtered by location (Region, TSC, and County) and date
(open to traffic date). In the Export Data Details pane, users can specify Segment Identifiers
and Export Type, such as job details, lanes/shoulders and their layers, median information,
etc. Once an Export Type is selected, additional selectable sub-items (data columns) will
appear in the pane.

Table 7-1 outlines the Export Types and their associated selectable items.
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Export

Types

Table 7-1. Summary of Export Types and Selectable Items

Export Type Selectable Items (Column Headers)

e Non JobNet Job Type Work Type Code Description
e Special Project Type Date (Open to Traffic)

Job Details e National Pavement Study Number Date Type
e State Pavement Study Number Fix Life
e Work Type Code Project Comment
e Year (Constructed) Lane Type

Lane: Layers & Details e Lane Number Layer Number
e Lane Surface Type Layer Name
e Lane Width Attributes (Name & Value)
e Year (Constructed) Layer Name

Lane: Aggregates e Lane Number Aggregatfe Name
e Llane Surface Type Source/Pit Number
e Layer Number
e Side Indicator Paved Thickness
e Surface Type Paving Width

Shoulder: Layers & e Corrugations (Rumble Strip) Layer Number

Details e Parking Lane Layer Name
e Paved Width Attributes (Name & Value)
e Total Width
e Side Indicator Layer Name

Shoulder: Aggregates

geres e Surface Type Aggregate Name

e Layer Number Source/Pit Number

Curb & Gutter: Details ¢ Side Indicator Attributes (Name & Value)

Median: Details

Median Width

e Median Type

Below is an export output example for the following search criteria:

> Export Filter: Grand Region — 2015 to 2022
> Export Type: Job Details

PR PR PR Road Name County TSC Region JobNet NonlobNet NonlobNet Work Work Type Description Date (O.pen F!x
18 Number BMP EMP Job ID  lob ID Job Type Type Code to Traffic) Life
=8l 405205 0.268 0.353 US-BR-131  Kent Grand Rapids Grand 122656 450 Full Depth Concrete Pavement Repair  10/29/2016
£l 3411717 0.697 0.698 S US131/W M Kent Grand Rapids Grand 123213 457 Concrete Joints Reseal 10/2/2015 3
E3 105307 0.091 0.166 CONN-44 Kent Grand Rapids Grand 126134 408 Milling & One Course Asphalt Overlay 10/29/2016 5
EMl 405310 0O 0.219 US-BR-131  Kent Grand Rapids Grand 126134 408 Milling & One Course Asphalt Overlay 10/29/2018 5
G 405310 0.343 0.459 US-BR-131  Kent Grand Rapids Grand 126134 408 Milling & One Course Asphalt Overlay 10/29/2016 5
il 525709 6.229 6.23 M-20 Mecosta  Cadillac Grand 128672 456 Asphalt Crack Treatment 9/19/2017 2
-0 407204  8.803 12.17 Broadmoor AvKent Grand Rapids Grand TWA165043 TWA 450 Full Depth Concrete Pavement Repair  9/30/2016 5
=M 407204 1445 14.53 Broadmoor AvKent Grand Rapids Grand P41051-031246 Permit 172 Right Turn Lane 6/8/2015 10
il 742501 0 0.101 WI196 Ottawa Muskegon Grand TWA225059 TWA 408 Milling & One Course Asphalt Overlay 9/29/2022 4
il 742501 0.101 0.299 W96 Ottawa Muskegon Grand TWA225059 TWA 408 Milling & One Course Asphalt Overlay 9/29/2022 a
GE8 410410  0.132 0.133 Hall/N US 131 Kent Grand Rapids Grand 122656 450 Full Depth Concrete Pavement Repair  10/29/2016 6
§EN 411109 0.068 0.069 SUS131/W BLKent Grand Rapids Grand 122656 450 Full Depth Concrete Pavement Repair | 10/29/2016 6
§¥8 411201 0.125 0.126 S US131/Cent Kent Grand Rapids Grand 122656 450 Full Depth Concrete Pavement Repair 10/29/2016 6
AF) 3540055 1.304 7.219 120th Ave Mecosta  Cadillac Grand W122622 Warranty 405 Overband Crack Fill 8/15/2017 1]
i 423610 19.82 19.82 M-37 Kent Grand Rapids Grand 122658 408 Milling & One Course Asphalt Overlay 8/22/2017 10
g 1203310 104 1051 S Sheridan Rd Montcalm Cadillac Grand M31725 Maintenance 160 Reconstruction 8/30/2017 14
gf) 1203310 10.51 10.62 S Sheridan Rd Montcalm Cadillac Grand M31725 Maintenance 160 Reconstruction 8/30/2017 14
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7.3 Search Segment(s) Submenu

Overview

Search
Segment
Criteria

The Search Segment(s) submenu allows users to quickly search for finalized PHD project data
within the PHD interface. Four different search options are available to locate the specifically
desired information. Once the segment or segments are located, more specific single

segment information is available, including work type, open to traffic date, lane, shoulder,
layers, and other job details. This can save users time and can aid in project planning and
scoping processes.

The four search types (defined by the four panes shown on the Search screen) are listed
below. These search type panes cannot be used in combination with each other. Users should

only make selections or enter data in one pane per search.

¢ General Criteria
o This allows users to search by location information, including Region, TSC, County,
and Route.
o This search also allows users to search for segments with specified comments from
the Segment or Project Comment boxes.
o Attribute Characteristic/Aggregate Characteristic selection allows users to search for
Layers, Layer Attributes, Attribute Values, Layer Aggregates, or Aggregate Sources.
o PR Criteria
o This allows users to search by PR Number and Milepoint limits. The results will list
segments that have any section within the specified PR milepoints.
o CS Criteria
o This allows users to search by CS Number and Milepoint limits. The results will list
segments that have any section within the specified CS milepoints.
e Job Number Criteria
o This allows users to search by job number. The results will list all segments associated
with the specified job number.

T «:: Reports | Search Role[s] :: Data Owner , System Administrator
General Criteria [Hide ]V
- Reports & Searches
i :
——— Region lany ]
Tsc :
» Search Segment(s) County .
» Construction History Route .
» Material Information Comments :}
» (I ® Attribute Characteristic O Aggregate Characteristic
» Network Inventory Attribute Characteristic
» Work Type Layer : [Any v
» MAP Reconciliation Attribute :
+ Administration Attribute Value :
PR Criteria [Hide ]V

PR Number : :] BMP : EMP :

CS Criteria [Hide 1V
N R B+ B - S SR
Number ) BMP ) EMP )

Job Number Criteria [Hide ]V
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View
Segments

Segment
Details

After selecting and/or entering the filters identifiers for the Criteria search option, select the
View Segments button at the bottom of the screen to view search results.

Segments matching the search criteria will be listed in the View Segments screen. The

segments can be identified and sorted by the column headers. Segments are unique to the
jobs they were created in. Each segment can be selected to view its lane and shoulder details.
Access details by clicking on the PR Number of the desired segment. Subsequently, the

Segment Details screen will display.
The following is an example of the View Segments screen from a PR Criteria Search:

«:: Reports | View Segments Role[s] :: Data Owner, System Administrator

Change Criteria

+ Post Constr. Data

- Reports & Searches

» Export Data PR Criteria [PR#:962706, BMP: , EMP: ]
Search Segment(s)
Road Name A |Job ID PR Number | PR BMP Open to Traffic
S Date
Construction History

¥

¥

EI69 Suff_PR962706_BMP25.596 962706 26.584 26.603 10/01/2014 [d]
% (S D EI169 85489 962706 26.661 26.981 10/31/2015 [2]
» Material Quantity E169 85489 962706 26.565 26.661 10/31/2015 [al
» Network Inventory EI69 85489 962706 26.981 27.059 10/31/2015 [2]

1-69 Suff_PR962706_BMP25.596 962706 25.97 26.588 10/01/2014 [d]
» Work Type

[a] - Open to Traffic Date / [b] - Let Date / [<] - A Phase start date / [d] - Sufficiency Year_Imp / [e] -
» MAP Reconciliation AASHTOWare Project Open to Traffic Date / [f] - AP All Contract Work Completed Date

+ Administration Page: 1 of 23
[ 2345

By selecting the PR_ Number of one of the segments from the View Segments screen, the
Segment Details screen will display. This screen displays the Road Segment pane and Lane
Summary/Shoulder/Curb & Gutter tabs. View Lane Details by selecting the Lane Summary

tab, view Shoulder Details by selecting the Shoulder tab, and view Curb Details by selecting
the Curb Gutter tab. The Road Segment pane displays general segment information, such as
PR# and MP, Route, and Median Details. Note that Simplified CPM jobs/segments will not
have lanes, so only layers will be shown.

The following is an example of the Segment Details screen:

Road Segment [ PR #-962706 / MP : 26.661 ... 26.981] [Hide 1Y
PR Version 22 Route o I-69

PR Number : 962706 County . St. Clair

PR BMP 1 26.661 TsC : Huron

PR EMP : 26.981 Region : Bay

Segment

Comments )

Median Type . Graded with ditch

Median Width : 100.0

Lane Width (in Year ne Partial Width | Paving Width
sutce e | (Corcirucen (et
1.0 mpi | LLNEHEPED s Mainline No

Concrete Pvmt

2.0 12.0fc | JPCPdointed Plain ;5 Mainline No N/A

Concrete Pvmt
Back
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7.4 Reports

PHD
Reports

The following reports can be generated in PHD through the Reports & Searches menu:

1. Construction History Report: shows all data entry on a specified roadway.

2. Material Information Report: lists segments with specific layer attribute(s) and/or
aggregate within specified location limits.

3. Material Quantity Report: compares HMA and PCC quantities placed during a specified
time period within specified location limits.

4. Network Inventory Report: provides lane or shoulder miles of rigid, flexible, and
composite pavement as specified by location, year, and trunkline type (freeway or non-
freeway).

5. Work Type Report: shows segments with a selected Work Type Code for a specified
location, year range, layer, layer attribute, and/or layer attribute.

6. MAP Reconciliation Report: lists projects from the JobNet database that are not yet
entered into PHD.

7.4.1 Construction History Report

Overview

Search
Options

The Construction History Report shows all data entry on a specified roadway, including Job
Details (Job ID, WTC, Fix Life, Open to Traffic Date, Segments PR and MPs), Segment Details
(Number of Lanes, Shoulder Details, Curb & Gutter Details, Median Type and Width, etc.),
Lanes/Shoulder, Curb & Gutter Details (Surface Type, Lane Type and Width, Lane Layers,
Shoulder Total and Paved Widths, Shoulder Surface Type, etc.), and Layers/ Repair Work
Attributes. The Construction History Report is particularly useful for scoping and estimating
future road projects. This report outputs in PDF format and Excel file (CVS format) for saving
and data processing.

Four different search options are available and listed below. These search type panes cannot
be used in combination with each other. Users should only make selections or enter data in
one pane per search.

e Report Data Filter
o This allows users to search by location information, including Region, TSC, County,
Route, and PR Numbers. Information will be separated by job numbers, to the most
recent 3 projects. Thus, older projects are not displayed.
o Specific PR (Physical Reference) and Specific CS (Control Section) Segment Details
o This allows users to search by PR/CS Numbers and Milepoint limits. The results will
list segments that have any section within the specified PR/CS milepoints, so the
retrieved segment(s) may actually be longer than the specified limits. Information will
be separated by job numbers, to the most recent 3 projects. Thus, older projects are
not displayed.
o Specific Job Details
o This allows users to search by job number. The results will list all segments associated
with the specified job number.
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+ Post Constr. Data
- Reports & Searches

» Export Data

» Search Segment(s)

< :: Reports | Construction History Report Filter Role[s] :: Data Owner, System Administrator

Report Data Filter

Region : ‘Select Region V‘ TSC : ‘Se\ect TSC v ‘ County : ‘ Select County V‘
Route : |Select a Route v PR Numbers : |Select a PR Number v

» Construction History
» Material Information
» Material Quantity

» Network Inventory
» Work Type

» MAP Reconciliation

+ Administration

Specific PR (Physical Reference) Segment Details

Specific CS (Control Section) Segment Details
Y m— - S |
: BMP ) EMP :

PR Number | prEMP : | J

CS Number

Specific Job Details Report Format

. —
> Specific Job Details: Job Number — 108909
Report Format: PDF
> :
Construction History Report Shoulder, Curb & Gtter Detaiks
Pavement Type Attribute. Left Side Right Side
Job Semmary e Stnp) N N
Shoulder Parking Lane N N
P -
|Overlay . o 3 Paved Sarface Type Flexible Flexible
1. Construction Cost or A Phase CTD from MPINS / /.. Open to Traffic Date / ™ - Let Date / 1. A Phase start date / ). Sufficiency Year_lmp /). Left Sude Shoulder Layers
AASHTOWare Protect Open to Traffic Date / 1 . AP All Coatract Work Completed Date Pavement Atribaie Value. I‘ Aggregale Pit / Source
e
AW (Actual) 264 Man Sand 41-117
Region I TSC I County | Route I PR Number PR BMP PR EMP
| Applscation Rate 170 Pounds Per Square Yard 3854 41-11
|Grand \(nr.md Rapids ‘Acm lu .57 |uwu 5107, 5.209)
Lane [1.0), Lane Type [Mainline], Sectional Details [Surface Type:Flexible / Width: 12.00 ft / Partial Width Paving: No / Paving Width: N/A |
G Pavement Attribute Value Aggregate Pit/ Sausce roe,
AWI (Actual) 264 Man Sand 41117 e —
Mix Type - HMA Top Course SE3
e i [Shingles Used N
Asphalt Binder PG 58-28 NS 41117
spal | Warm Mix N
Certified Michi P & Materials
sopter o owon s
Mix Design No. (Case p— — o m Mix Additive Used
HMA Top Course Seasitive) 3 gz i (Cold Milling Depth 1.5 Tnches
13 Mix Type - HMA Top Course |SE3 \Cold Milling Type Uniform Depth of Milling per Plan
Shingles Used N Right Side Shoulder Layers
i N P | Assbs Vae P P

7.4.2 Material Information Report

Overview

The Material Information Report lists segments with specific layer attribute(s) and/or
aggregate during a specified time period and within specified location limits. Layers and their
attributes or aggregate can be searched by location information, including Region, TSC,
County, Route, and PR Numbers.

The Material Information Report is particularly useful for researching specific materials,
performing material cost analyses, and obtaining historical reference information. This report
outputs in PDF format and Excel file (CVS format) for saving and data processing.
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To generate the report, users need to select the location information and time period from
the Geographic Filter, select the Filter Type (Aggregate Filter or Attribute Filter), select the
Layer and its attributes or aggregate, and Add the Attribute Filter (if Attribute Filter selected).
If Attribute Filter is selected, individual or multiple attribute/value/comment filters can also
be used. Once all selections and filters are made, select Generate Report.

Users can also use the Sort Definition pane to define the order of the segments in the report
list (sorted by Job Number, Route, County, and/or Work Type Code), and use Report Format
to select the format of the output file (PDF or Excel file).

4 :: Reports | Material Information Report Filter Role[s] :: Data Owner, System Administrator
+ Post Constr. Data
Geographic Filter Sort Definition
- Reports & Searches -
Region : [ State wide [ | Field Order
> Export Data TsC . [ATsSCs ~] [|[3eb Number ~v[asc v]
» Search Segment(s) County : [All Counties ~] J[Route v[asc ]
> _Construction History Route : [Select a Route ~| | cCounty ~v[asc v
» Material Information PR Numbers  : |Select a PR Number ~ | ||[work Type Code  w[aSC  w|
» Material Quantity From Year : \:| [yyyyl
Report Format
o CE e Ty To vear s ]y
N
» Work Type - @ poF O Excel
Choose the Filter Type
» MAP Reconciliation
o] Aggregate Filter @ attribute Filter
+ Administration
Report Data Attribute Filter

Layer . [select a Layer v
Attribute @ | Select an Attribute v

S —
e B

Box Text ~

Add Attribute Filter

Attribute Filter List [ Condition : OR ]

] Layer Attribute Value
Empty - Add Attribute Value Filter Items

Remove Filter(s)

Generate Report | | Reset Filter

Below is an export output example for the following search criteria:

> Geographic Filter: North Region — from 2010 to 2022

Layer: Chip Seal

Attribute: Emulsified Asphalt Supplier - Michigan Paving & Materials Co., Monroe, Ml.
Report Format: Excel

Y V V

A

1 Report Criteria

#3 Pavement |Attribute | Attribute Value

EN Chip Seal |Emu|siﬁed Asphalt Supplier | Michigan Paving & Materials Co., Monroe, MI

4|

5 Material Information Report

-} Job Number Route County |PR Number|PR BMP|PR EMP| Date RSL |RSL Year| Work Type
T 120249|M-75 Charlevoix 1242004 0.27] 3.642 7/23/14 0f 0]400 - "Multiple Course Chip Seal"
8 120249|M-75 Charlevoix 1242004  3.642] 4.26| 7/23/14 0f 0]400 - "Multiple Course Chip Seal"
g 120249|M-75 Charlevoix 1242004  3.642] 4.26| 7/23/14 0f 0400 - "Multiple Course Chip Seal”
F 120333|M-32 Qgemaw 1005503| 20.471| 21.905 7/6/15 0| 0]440 - "Single Course Chip Seal"
F 120333|M-33 Ogemaw 1005503 0| 7.824] 7/6/15 0f 0440 - "Single Course Chip Seal"
12 120333|M-32 Qgemaw 1005503 0] 7.824 7/6/15 0| 0]440 - "Single Course Chip Seal"
E 123277|M-33 Oscoda 1335006] 5.079| 10.865 6/26/15 0f 0440 - "Single Course Chip Seal"
H 123277|M-32 Oscoda 1335006 5.079| 10.865 6/26/15 0| 0]440 - "Single Course Chip Seal"
? 124929|M-33 Ogemaw 1005503] 11.009] 17.203 7/6/15 0f 0440 - "Single Course Chip Seal"
E 124929|M-33 Ogemaw 1005503] 11.009| 17.203 7/6/15 0f 0440 - "Single Course Chip Seal"
F 128572|M-72 Kalkaska 1097603 1.435 1.633 8/29/17 0| 0400 - "Multiple Course Chip Seal”
E 128572|M-72 Kalkaska 1097603 10.698| 11.427 8/29/17 0f 0400 - "Multiple Course Chip Seal”
E 204228|M-204 Leelanau 1147907 3.388] 3.64| 10/10/2019 0f 0]443 - "One Course Asphalt Overlay"”
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7.4.3 Material Quantity Report

Overview The Material Quantity Report compares HMA and PCC quantities placed during a specified
time period and within specified location limits. HMA and PCC quantities are calculated by
lane miles, volume, and area. This report outputs in PDF format and Excel file (CVS format)
for saving and data processing.

4 :: Reports | Material Quantity Report Filter Role[s] :: Data Owner, System Administrator

Report Description

This report would be useful for looking at historical usage patterns of PCC and HMA pavements
» Export Data regionally and statewide.

+ Post Constr. Data

~- Reports & Searches

» Search Segment(s)
» Construction History Report Data Filter
» Material Information Report : ‘ HMA vs PCC vl
— Regin e
I From Year : \:I [yyyyl ToYear : [yyyy]

@® ppF O Excel

» Network Inventory

» Work Type

Reset Filter

» MAP Reconciliation

Below is an export output example for the following search criteria:

> Region/TSC: Metro — All TSCs
> Time Period: 2012 to 2022
> Report Format: PDF

Material Quantity Report
Report Criteria
Region TSC From Year To Year
Metro All TSCs 2012 2022
Report Data
Lane Miles (miles) Volume (cu. yds) / Tonnage (tons) Area (sq. yds)
Region TSC
PCC HMA PCC HMA PCC HMA

Metro Detroit 3732 233.64 79.426.53 154,927.81 254,941.87 1,649,430.76
Metro Macomb 118.32 615.74] 233,181.65 509,131.70 829,804.93 4,298,763.90
Metro Oakland 46.59 256.49) 112,853.37 195,120.71 333,513.07 1,754,264.87
Metro Taylor 153.83 36.63| 340,010.53 34,768.91 1,097,276.11 260,377.29

Metro Region Total 356.06 1,142,504 765.472.08 893,949.13 2,515,535.99 7.962,836.82,

7.4.4 Network Inventory Report

Overview The Network Inventory Report provides lane or shoulder miles of rigid, flexible, and
composite pavement as specified by location, year, and trunkline type (freeway or non-
freeway). The lane-mile quantities are derived from the accumulation of all entered
information (in PHD) to the end of the year specified. Please note that the report doesn’t
necessarily show the entire network for the given search criteria — it only shows what has
been entered/reported in PHD.

The Network Inventory Report is particularly useful for locating and quantifying trunkline
pavement types. Additionally, this report can also indicate pavement type trends. This report
outputs in PDF format.
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To generate the report, select from the Report Data Filter pane the location (Region, TSC,
County, and Route), year, trunkline type (freeway or non-freeway), and Lane or Shoulder
search. Note that the year entry will report quantity data for all constructed segments that
occurred prior to December 31st of that entered year. Use the Report Detail Level pane to
select the report level of detail. By selecting a more specific level, the report will output more
information to identify that specified level. For example, if Route is the selected level of detail,
lane miles for all trunkline routes will be shown within the selected Region/TSC/County.

4 :: Reports | Network Inventory Report Filter Role[s] :: Data Owner, System Administrator
* Post Constr. Data
Report Data Filter I Report Detail Level
- Reports & Searches
Region : | All Regions v @ Region
» Export Data
TSC ;| All TSCs hd O TsC
» Search segmen() SEIT e —
County : | All Counties O County
» Construction History Route : | All Routes hd C
3 ) Route
B [T =i End of Year : 2023 | [yyyy]
» Material Quantity O Freeway
Route Type 1 O Non Freeway
o
» Work Ty
ype Report Type . S Lane Miles by Surface Type
» MAP Reconciliation L shoulder Miles by Surface Type
- . s
AdminiStration

Below is an export output example for the following search criteria:

> Region/TSC/County: Southwest — All TSCs and Counties

» Time Period: End of 2022
> Route Type: Both Freeways and Non-Freeways
> Report Type: Lane Miles by Surface Type
Network Inventory Report - Lane Miles by Surface Type - County Level
Lane Miles
Region TSC County Route
Flexible Rigid ‘Composite Other
Berrien All 0.000 1119 0.000 0.000
Coloma(inactive)
Van Buren All 0.000 0.562 0.000 0,000
Colomal inactive) TSC Totals) 000 1.681 0000 0000
Berrien All 307.016 260.209 262.002 0.000
Cass All 166,029 0328 118.947 1838
Kalamazoo
Kalamazoo All 159.436 114.331 325.343 0,000
Southwest
Van Buren All 229.647 88.747 §7.247 0.000
Kalamazoo TSC Totals| 862.128 463.615 793.539 1838
Branch All 40.252 131.430 92.658 0.000
Marshall Calhoun All 236.100 140,502 344.783 0.292
St. Joseph All 180.297 4.052 190.113 0.000
Marshall TSC Totals| 456.649 276.284 627.554 0.292
Southwest Region Totals) 1318.777 T41.580 1421.093 8.130
State Totals| 1318.777 741.580 1421.093 8.130
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7.4.5 Work Type Report

Overview

The Work Type Report shows segments with a selected Work Type Code (WTC) for a specified
location, year range, and/or layer. The listed segments can be sorted by Region, TSC, year,
and/or Work Type Code in ascending or descending orders.

The Work Type Report is particularly useful to determine where and how often specific types
of work and pavement are being applied throughout the state. This report outputs in PDF
format and Excel file (CVS format) for saving and data processing.

To generate the report, select from the Report Data Filter pane the Work Type, Region/TSC,

and year range [From Year starts from January 1 of the entered year, and To Year ends on
December 31° of the entered year]. If a layer is selected, the report output will show all
projects with the selected Work Type and have the selected layer. If a layer is not selected,
the report output will show all projects with the selected Work Type regardless of layer type.

« :: Reports | Work Type Report Filter Role[s] :: Data Owner, System Administrator |
+ Post Constr. Data ? I ype Repo sl Vet
o Ry Report Data Filter Sort Definition
- Reports arches .
work Type  : [ 160 - Reconstruction 43| | Field Order
» Export Data Region : [Bay v [Region v]asc ~|
» Search Segment(s) TSC : | Select a TSC v [Tsc vasc v|
» Construction History From Year : 2020| [yyyy] | Year v | ASC v|
» Material Information To Year : 2022 | [yyyy] [Work Type Code v [asC v
» Material Quantity Layer : [PCC Pavement v =—
Attribute . | Select an Attribute v eport Form
» Network Inventory _
Value ] | [% - wildcard] @® ppF O Excel
+ Administration

Below is an export output example for the following search criteria:

» Work Type: Reconstruction
> Region/TSC: Bay — All TSCs
» Time Period: 2020 - 2022
» Layer: PCC Pavement

Work Type Report
Job . PR Lane
Noo | Region TSC Route Nuber | PRBMP | PREMP [ Cobe Date Work Type |
1002 | By TTaron 00 To200 TTO2T] 12000 U3s | 2021-12.00 TTRCCOnSTICTOn
130024 |Bay Huron :‘gg{{‘j&“gﬂ 1847306 0 04 0.40] 2021-12-09 |160 - "Reconstruction”
130024 |Bay Huron 1-69 962902 7.974 8.062 0.26| 2021-12-09 |160 - "Reconstruction”
130024  |Bay Huron 1-69 962902 11.015 1116 0.43| 2021-12-09 |160 - "Reconstruction”
130024  |Bay Huron 1-69 962902 11.553 11.921 0.74] 2021-12-09 160 - "Reconstruction”
130024  |Bay Huron 1-69 962902 12.046 12.406 0.72] 2021-12-09 160 - "Reconstruction”
130024  |Bay Huron 1-69 962902 6.947 7.053 0.32| 2021-12-09 |160 - "Reconstruction”
130024 | Bay Huron 1-69 962902 7.053 7.974 1.84| 2021-12-09 |160 - "Reconstruction”
130024  |Bay Huron 1-69 962902 8.062( 11.015 5.91| 2021-12-09 |160 - "Reconstruction”
130024  |Bay Huron 1-69 962902 11.16 11.553 0.79] 2021-12-09 160 - "Reconstruction”
130024  |Bay Huron 1-69 962706 7.957 8.082 0.38] 2021-12-09 160 - "Reconstruction”
130024 |Bay Huron 1-69 962902 5.856 6.947 2.18] 2021-12-09 | 160 - "Reconstruction”
130024 |Bay Huron N1ORiley 1 1847308 o 038s|  039] 2021-12:09 |160- "Reconstruction”
130024 [Bay  |Huron WI1GORiley | 1sa7308| 0385  0.626) 048 2021-12:09 |160- "Reconstruetion”
130024 |Bay Huron Ny L 69 1847403 0 045 0.45] 2021-12-09 |160 - "Reconstruction”
Riley
130024  |Bay Huron Center/W 169 | 1847307 0 0.392 0.39] 2021-12-09 160 - "Reconstruction”
RAMP
130024 |Bay Huron Ranipiney | 547407 o] 0309  031] 2021-12:09 |160- "Reconstruction”
130024 |Bay Huron Woheomimey | gazan| 0309 0.419)  022] 2021-12:09 [160- "Reconsiruction”

56



7.4.6 MAP Reconciliation Report

Overview

The MAP Reconciliation Report shows projects from the JobNet database that have not yet
entered into PHD. These projects can be filtered by location, JobNet Job Type, Funding
Template, Work Type Code, and letting year range.

The MAP Reconciliation Report can help Data Entry users locate projects for data entry. It
can also help Data Owners verify that all JobNet jobs are entered. The report can also help
locate older projects that may have been overlooked. This report outputs in PDF format.

(NOTE 1: The MAP Reconciliation Report considers JobNet projects as entered in PHD whem
ajobis created. Therefore, projects not shown as missing might not be finalized in the PHD
database. It is possible that these projects are still in a user’s Modify or Review areas.

NOTE 2: Depending on the Funding Template in the Data Filter, the MAP Reconciliation
Report may include some non-pavement related jobs (that should not be entered in PHD).

kUsers should carefully review the report to ignore these jobs. )

To generate the report, users must select Location Information (Region/TSC), JobNet Job
Type (Trunkline, Multi-Modal, Maintenance, or Local), Funding Template (multiple selection
by holding the ctrl key, usually select Freeway Resurfacing Program, Non-Freeway
Resurfacing Program (NFRP), Road - Capital Preventive Maintenance, and Road -
Rehabilitation and Reconstruction). Users can also search based on Work Type and Letting
Period.

4 1! Reports | MAP Recondiliation Report Filter Role[s] :: Data Owner, System Administrator
+ Post Constr. Data

Report Data Filter

- Reports & Searches

Locale Information Report Detail Level

» Export Data

Region : | Nerth hd

- Region Level ® TSC Level
» Search Segment(s) TSC . | Traverse City hd

» Construction History

JobNet Job Type
» Material Information @ Trunkline O Multi-Modal O Maintenance O Local

» Material Quantity

Funding Template [ Multiple Select] Work Type [ Multiple Select ]

» Network Inventory N:wl;logz «||all work Types : B
101 - Relocate Roadside Obstacles
» Work Type Noise Abatement 102 - Rumble Strips - Shoulder
103 - Intersection Geo Improvements for Signalizatic
Operations 105 - Vertical and Horizontal Alignement Revision(s)

Passing Relief Lanes (PRL) 110 - Non-Freeway Sign Replacement

+ Administration Planning Studies 111 - Pavement Marking
Program Development / Scoping 112 - Traffic Signals
Pump Station Rehabilitation 113 - Overhead Sign Structures
Railroad Crossings Program 114 - Freeway Sign Replacement
Recreation Trails 116 - Substructure Repair
Rest Areas 117 - Substructure Replacement
Road - Capital Preventive Maintenance 120 - Intersection Improvements

Road - Rehabilitation and Reconstruction
Safe Routes to Schools

Letting Period

From : (mm/cdvyyy]
T (mm/ddryyyy]

121 - Construct Roadway Lighting
122 - Construct Median Barrier
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Below is an export output example for the following search criteria:

>
>
>
>
>

Region/TSC: North — Traverse City
JobNet Job Type: Trunkline
Funding Template: Road - Rehabilitation and Reconstruction
Work Type: All Work Types

Letting Period: 01/01/2020 to 12/31/2022

Report Filter Criteria

MAP Reconciliation Report - TSC Level

Region

TSC

JobNet Job Type

Work Type(s)

Funding T )

Time Period

North

Report Da

Traverse City

Aa

Trunkline

All

Road - Rehabilitation and Reconstruction

01/01/2020 - 10/31/2022

Region ‘TSC ‘ No. of Outstanding MAP Jobs (Jobs not yet in PHD) ‘ Percentage of existing MAP Jobs in PHD

North ‘Truvcrsc City ‘5 ‘54‘55% “[6/11)

ng& o | Major Route Major County Maujor Work Type Funding Template I;n';? LedDate
216186 |M-55 Wexford 112 = Traffic Signals Road - Rehabilitation and Reconstruction N Not Available
205228 | Old 55 Wexford 164 - Asphalt R Road - Rehabilitation and Reconstruction 10/02/2020
200954 |US-31 Benzie 684 - Milling and Two Course Asphalt Resurfacing Road - Rehabilitation and Reconstruction Y 10/01/2021
131656 |US-31 Benzie 684 - Milling and Two Course Asphalt Resurfacing Road - Rehabilitation and Reconstruction Y 10/01/2021
129932 |M-37 Grand Traverse 167 - Crush & Shape & Asphalt Resurfacing Road - Rehabilitation and Reconstruction Y 01/08/2021
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Appendix A. Frequently Asked Questions

A.1l Introduction

In Appendix A, users can find answers to commonly asked questions by PHD Data Entry and Data Owner
users. If users have specific questions for PHD interface; data collection, preparation, or entry; or exporting
PHD data, they are encouraged to search within this Appendix. If users cannot find the answer, please
contact PHD Administrators or the Region’s designated PHD liaison.

PHD Administrators:

Fawaz Kaseer, at KaseerF@michigan.gov or 517-599-1498

Justin Schenkel, at schenkelj@michigan.gov or 517-242-2788

Region designated PHD liaisons:

Grand Region: Bill Loehle Metro Region: Marji Zabel North Region: Margaret Szajner
Bay Region: Tyler Lemieux Southwest Region: Kyle Rudlaff Superior Region: Alison Hamlin
University Region: Robert Green

The following seven sections list the commonly asked questions (and answers) related to the PHD data entry
process.

Data Collection Resources

General Data Entry
Job Details
Segment Details

Lane Details
Shoulder/Curb & Gutter Details
Layers & Layer Attributes

YV VY VYV VYV

A.2 Data Collection Resources

What resources can be used to find information needed for data entry?

The following resources, databases, or programs may be used to aid in finding data for entry:

R/

+* ProjectWise: an MDOT's electronic document tool used by both internal MDOT staff and external
partners (like consultants) to manage documentation for construction projects. Most construction
records required for PHD entry can be gathered from ProjectWise.

MDOT PR Finder: an online mapping application that helps to identify the PR number and milepoints
for all roads in the state of Michigan. This website is open to the public.

3

%

3

%

MDOT Construction Contract Inquiry (CCI): an online database with project-specific information, such

as contract-level information, contract modifications, and contractor payments that reflect “As Built”
information. CCl database is open to the public.
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+» Google Maps/Google Earth: tools for aerial imagery. In many cases, the Google aerial imagery is
captured recently (and after the project’s completion date). In this case, certain pavement features can
be verified, such as the number of lanes, lane type, lane width, should width, median type and width,
and others.

The following construction-related documents and forms may be used to aid in finding data for entry:

> Project plans and proposal which include project location (PR numbers and milepoints), typical sections,
work items, etc. “As Built” plans are preferable, but if project information is being entered soon after
construction, these might not be available.

» Contract modifications to check for material changes made during construction.

» HMA Job Mix Formulas (JMF) (MDOT Form 1911) and concrete JMF (MDOT Form 1976).

» Report Of Quality Assurance Testing (MDOT Form 1903B) and Weekly Summary Of Certified Concrete
(MDOT Form 1155).

» Material Source List (MSL) (MDOT Form 0501), and the Material Certifications, Certificate of
Compliance, and/or Certificate of Analysis.

> Testing orders for surface seals and crack treatments.

> Delivery tickets (HMA, concrete, aggregate, etc.).

> Inspector’s Daily Reports (IDRs) (MDOT Form 1122B), Inspector’s Report of Concrete Placed (MDOT
Form 1174R), and/or Aggregate Inspection Daily Report (MDOT Form 1900).

» Record of Soils Recommendations (MDOT Form 0583)

NOTE: In case the construction documents for Non JobNet Jobs are unavailable or incomplete, contact
personnel who have direct knowledge of the work done and gather project related documentation. Enter
as much accurate information as is available.

What methods are being used around the state for capturing data? Is there a template for station to
mile-point conversions?

There is not an official form to fill in to capture PHD data. Some use spreadsheets for various input items
such as materials data and station to mile point conversions. Some use project plans to visually lay out sub-
segments with color coding.

The PHD Data Spreadsheet, which is available on the PHD informational website, can be used for PHD data

collection and can help format and organize PHD data. This spreadsheet can also be used to convert
stationing to mile-points. The beginning mile-point in reference to the beginning station is needed for
proper conversion. Also, station equations would need to be manually applied within the spreadsheet.
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A.3 General Data Entry

Do very short projects have to be entered into PHD?
Projects shorter than 0.1 mile are optional. Some short projects are required to be entered, such as when
lanes are added or reconstructed (turn lanes, for example).

Why don’t | see the measurement/layer/attribute | need to enter in the drop-down choices?

Contact the PHD Administrator to see if the desired measurement/layer/attribute can be added.

Can | add additional information that cannot be entered in any PHD screen?

Yes. To detail additional information that cannot be entered within a segment, Lane, or Shoulder details
screens, users can use the Segment Comments box or Project Comments box.

Should I always have to save data before exiting any screen within PHD?

Yes. Users must save the data (save as a “Draft” or “Complete” status) before exiting any screen (segment,
lane, shoulder, layer, etc.). Without saving, data will be lost when using Back, Cancel, or even navigating to
a different submenu. Similarly, data will be lost if a project is exited for any reason, including network or
connection issues.

Can | enter additional data after I click on finalize? How do | correct a project that has been finalized?

After a project has been finalized by a Data Entry person, it goes to a Data Owner for review. If the Data
Owner has not finalized it, they can reassign it to the Data Entry person so that data may be added or
corrected. If the Data Owner has finalized the project, it has to be unlocked by the PHD Administrator.
Please contact the PHD Administrator (with the Job ID identified) to unlock it.

Should I finalize a multi-year project after the first year?
No. Save the job in “Draft” status. When the project construction is complete (the following year(s)),

complete the data entry in PHD, and then finalize the job.

Should | enter pavement projects outside of the paved shoulder (i.e., sidewalks, non-motorized path,
or Portable Intermittent Truck Weigh Stations (PITWS))?

Work outside of the shoulder or curb and gutter is not included in PHD, (except for median information).
However, items such as non-motorized paths within the shoulder or lanes must be included but are not
separated. The width should be included in other adjacent lanes or shoulders. A comment can then be
added to the Project Comment and/or Segment Comment boxes.

Pavement projects outside of the shoulder/curb and gutter (like the PITWS) cannot be entered, but can be
noted by adding a note in the Project and/or Segment Comment boxes.
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A.4 Job Details

How do | enter projects that have more than one job number?

Enter the work associated with each job number separately. This will be especially important if PHD reports
are created/exported based on a job number or when information related to specific job numbers is needed.
An example of this is mainline work is done under one job number and shoulder work is done under another
job number. Another example is an intersection improvement done under one job number and work
outside the intersection done under another job number. DO NOT enter projects or job numbers with non-
pavement work such as landscaping, freeway lighting, signage, etc.

How do | assign Job ID at job creation? If | used an incorrect job ID at job creation, can | change it later?

For JobNet Jobs, the PHD Job ID is simply the numeric value of the Job Number from the JobNet database
(5 or 6 digit job number). For Non JobNet Jobs, Table 2-2 defines the types of Non JobNet projects and Job
ID naming convention guidelines.

For Non JobNet jobs, if an incorrect job ID was used when creating the job, users can edit/change the Non
JobNet job ID later, without losing entered data. For JobNet jobs, users cannot change the job ID once
created. Users must contact the PHD Administrator to correct the job ID.

CPM projects (such as crack seal) can cover a very large number of miles. This can take a lot of time
to enter due to the large number of segments. Can this be simplified?

Yes. CPM projects can be “simplified” by selecting ‘Yes’ for Simplified CPM Format, on the job creation
screen. The project must be a CPM project with Work Type Code 400 to 499. Simplified CPM jobs require
segment layer information only, and do not require segmentation based on lane or shoulder changes, do
not allow entry of lanes and their details, and do not allow entry of median information. This process will
streamline PHD CPM entry and make CPM projects much easier to enter. Note that the Simplified CPM
prompt can only be selected once, and will remain in the Simplified format for the duration of data entry. If
the CPM project includes HMA layers and/or different work/layers in each lane, the Simplified CPM Format
should not be used.

Why won’t PHD allow me to create a project with a segment outside of my TSC/region jurisdiction (a
multi-region project)?
In general, Data Entry users can only create projects and segments within the limits of their Region. If a

project crosses multiple regions, contact the PHD Administrator. The PHD Administrator can assign the Data
Entry User a ‘Statewide’ access in PHD, so the user can create and work on multi-region projects.

How should | flag a demonstration or experimental project? For example, | have one using crumb
rubber, or a different special material type.

If applicable, check the appropriate Special Project Type(s), in the Job Details box (at job creation). Add
notes to the Segment Comments box or Project Comments box to indicate crumb rubber use or any different

special material type.
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What is the Open to Traffic date?
It is the date when all the lanes have been opened to traffic. At PHD job creation, if the project is not yet
complete, enter an approximate placeholder and update the date when the project is complete.

Can | change the Fix Life when creating a job in PHD?

For JobNet jobs, users cannot change the Fix Life, because it is automatically generated from the JobNet
database.

For Non JobNet Jobs, and once a WTC is selected, the Fix Life will be auto-filled. However, users can change

the Fix Life. Click on the Fix Life Guide link within PHD to review the appropriate Fix Life per work type.
Consult the appropriate Pavement Management Engineer for further guidance or confirmation.

When creating a project in PHD, if the information pulled from the JobNet database is wrong, is there
a way to correct the data in JobNet and then have PHD pull the correct data?

PHD pulls information from the JobNet database (the Planning Database) only at PHD job creation. Changes
to JobNet database will not be reflected in PHD after job creation; therefore, corrections need to be made
in JobNet prior to job creation in PHD.

In PHD, only PR and milepoint information from the JobNet database can be corrected in PHD after job
creation. Other information like WTC and Fix Life cannot be corrected in PHD.

A.5 Segment Details

If PHD automatically generated the segments (PR numbers and milepoints), should | always keep those
segments in the PHD job?

At PHD job creation for JobNet jobs, preliminary segment information (PR numbers and milepoints) is
generated and is based on the originally planned or designed records (from JobNet database). However,
modifications to those segments or additional segments may still be needed since PHD entry should always
be based on "As Built” information. For example, an asphalt mill and fill project could be programmed to be
from 0 to 2.3 milepoints, but the "As Built” information could indicate a shorter mill and fill length (0 to 1.9
milepoints, for example).

Is there a minimum length of a segment?

No, there’s no minimum length, but segments less than 0.1 mile may be entered with the adjacent segment
at the user’s discretion (and Segmentation Rules can be waived). The exception is segments involving
additional lanes less than 0.1 mile (turn lanes, for example). These should be entered as new or
subsegments and not included in adjacent segments to capture that additional lane mileage.

Do Maintenance Crossovers and Temporary roads/routes have to be entered?

Crossovers, short roadways that connect both sides of a divided highway, should not be entered in PHD.
Temporary roads, constructed along a temporary alignment solely for use during construction, should not
be entered in PHD, since these are not part of the MDOT trunkline.
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Since the PR numbers for the rest areas include the parking area, does the parking area need to be

entered?

Yes. Enter the parking area as a lane and select the Lane Type “Rest Area Parking Lane”. Consider each
driving path as a separate lane and include parking spaces in the lane width. Note that ramps usually have
their own PR number and should not be included in this area.

Please note that this is different from how standard segments (mainline lanes) consider parking, which

includes parking on the shoulder. Please review What is included within the Shoulder width? for standard

segment parking entry.

y

F Lane Width a|

Entering ramps takes a lot of time. Do they have to be entered? If yes, how?

Yes, ramps are important assets and must be entered and tracked in PHD. The ramp is entered under its
own PR number, and the ramps PR number begins or ends at the 2’ gore point, so portions of the ramp that
are next to the mainline should be entered with the mainline. Please see the ramps Segmentation Example.

During construction, the length of a ramp was increased. In PHD, when | enter the new milepoints, |

get an error that they are outside the limits of the PR (exceeds the segment length). What should |

do?

PHD looks at the latest official PR Framework to make sure entered PR numbers and milepoints exist [PR
framework refers to the linear referencing system (LRS)]. When the milepoints for a PR change (this can be
checked using MDOT's PR Finder), that needs to be reflected in the next version of the Framework. This

typically happens around October each year. Since PHD data is typically entered before that (by January of
the same year), the error message occurs.

In this case, create the segment using the current PR milepoints limits, and save the segment (and the job)
in “Draft” status, until the new Framework version is released. However, if the milepoints for the PR did not
change between the current and next version of the Framework, and when the difference is small and within
the 0.1 mile, then limits of the PR in PHD can be used (not the actual PR limits), and a note/comment should
be added to the Segment Comments box. When the difference is greater than 0.1 mile, please notify the
PHD Administrator.

64


https://mdotgis.state.mi.us/portal/apps/webappviewer/index.html?id=c3aa2462a1e24e37a33184a33e5976aa

During construction, a new ramp or new roundabout was constructed. In PHD, when | enter the PR

number for the new ramp/roundabout, | get an error. What should | do?

PHD looks at the latest official PR Framework to make sure entered PR numbers and milepoints exist [PR
framework refers to the linear referencing system (LRS)]. When a new PR is created (this can be checked
using MDOT's PR Finder), that needs to be reflected in the next version of the Framework. This typically

happens around October each year. Since PHD data is typically entered before that (by January of the same
year), the error message occurs.

In this case, and in the Create Segment screen, select Future under the Latest PR Version. Users can create

a placeholder segment with any PR number and milepoint (without any restrictions). However, the
Framework Status of such segment in the PR Segment List will show as “Inactive” status. Users can complete
the data entry for any “Inactive” segment (such as lanes, shoulders, layers, etc.), but need to save the job in
a “Draft” status [since users cannot finalize the job until the Framework Status shows an “Active” status]. In
the next year’s PHD data entry cycle, and when the new alignment (a new ramp, a new roundabout, etc.) is
reflected in the PR framework, create the same segment again. The Framework Status of such segment in
the PR Segment List will show as “Active”. Then, Copy segment details of the “Complete” and/or “Inactive”
segment to the newly created “Active” segment. Delete the “Inactive” segment. Please refer to the Create
and Modify Segments section for more information.

How do | enter Median information? For segments with varying median width, what should | enter?

In the Segment Overview screen, select the Median Type (and Median Width, if applicable). Examples of

Median Types (selectable options in PHD) include Undivided, Concrete Barrier, Guardrail, Graded with ditch,
N/A (i.e., Ramp), etc. The Median Type “N/A (i.e., Ramp)” should only be used for one-way segments that
do not have a median (such as ramps). Two-way segments without medians should use the selection
“Undivided”.

For segments with varying median width, the median width in PHD is the predominant median width
including inner shoulders (if any). For example, see the figure below. Please note that Segmentation is not
required based on small changes in Median Width. However, segmentation is required based on significant
changes in Median Width and/or changes in Median type (i.e., going from a divided to undivided median).

Median information is only required for standard jobs and is not needed/shown for Simplified CPM Format
Jobs.
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A.6 Lane Details

Why do | have to enter data for each lane separately?

PHD is designed to capture occasional differences between lanes, including differences in Lane Type
(Mainline, Left/Right Turns, Passing Flare, etc.) and Paving Year. Some PHD reports require individual lane
details to provide the correct information, such as the quantities of HMA and concrete placed which is
provided by the Material Quantity Report. Another example is for tracking the actual paving date (for each
lane) for multi-year projects, which is important to determine Fix Lives and Service Lives as part of the
MDOT’s Life-Cycle Cost Analysis (LCCA) process.

In PHD, and when different lanes share similar details and layers, users can use the Copy Lane function to
copy lane details and/or layers of a “Complete” Lane to another lane. This can reduce data entry and save
users time if lanes are identical or have similar details.

Unlike the standard format, the Simplified CPM Format Jobs do not show different lanes, since jobs with
WTC 400 to 499 (Capital Preventive Maintenance jobs) usually have the same fixes/repairs across all lanes.
When should a tapered lane be considered a “lane” in PHD and have its own data entered?

A lane begins at the start of the taper and ends at the end of the taper. The full length between the
begin/end taper points should be considered as the total lane length. The varying width from 0’ to 12’ within
the tapered length is not separately accounted for. Please follow the Lane & Shoulder Numbering guidelines.

Mainline @
Mainline @ -
j "\ Passing Relief/ Flare @ - ‘\
Lane begins Lane ends
here PR MP INCREASING > here

How should | number each lane in PHD? Should | specify the Lane Type?

Lanes are always numbered right to left, facing toward increasing milepoints in the PR segment (regardless
of traffic direction). Lane 1 is the right-most through lane of the PR segment, and increasing lane numbers
2, 3, etc., are lanes left of Lane 1 (such as a passing lane, center turn lane, or an opposing traffic lane (if it is
the same PR number, i.e., undivided roadway)). Decreasing lane numbers 0, -1, etc., are lanes right of Lane
1 (such as ramp lane, passing flare, right turn lane). Typically, divided roadways have a different PR number
for each bound, so they are numbered separately. Please review the Lane & Shoulder Numbering guidelines

for more information and examples. One exception for the rules above is for a ramp when it is a separate
entity (i.e., the entire PR number represents only the ramp). In this case, the ramp is numbered as Lane 1.

Lane Type is a required input in PHD. Select the lane type from the drop-down list under the Lane Details
screen. Examples of lanes type include Mainline, Left/Right Turns, Off/On Ramps, Passing Flare, Weave, etc.
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For Lane Type, what is the difference between “Passing Relief” and “Passing Flare”? How should be
numbered?

Passing Flares can be constructed to facilitate traffic flow, particularly in rural areas, where there is no need
for added through lanes. They allow traffic to flow around left-turning vehicles without significantly reducing
speed on the main roadway.

Passing Relief lanes (usually on two-lane rural roads) provide passing opportunities that would otherwise
be scarce where there are extensive no-passing zones, high opposing traffic volumes, or both. According to
MDOT’s Road Design Manual, Passing Relief lanes must be 12’ wide and are longer than passing flares.
Passing Flares can be less than 12’ wide.

Please follow the Lane & Shoulder Numbering guidelines when numbering Passing Flares and Passing Relief

lanes. For a Passing Relief Lane of one mile and longer, the Lane can be numbered similarly to a mainline
(as Lane 1 - the right-most through lane of the PR segment). If a Passing Relief Lane is less than one mile,
the Lane can be numbered with decreasing lane numbers 0, -1, etc. (right of Lane 1), similar to ramp lane,
right turn lane, etc. Passing Relief Lanes on the left side should just be numbered in the standard increasing
number protocol.

@ €« 5

————————————————————————————————— t

©) < 9

Mainline @ — a

""""""""" .‘I.""""""' -

__ Manine @ - > £

\ Passing Relief @ - =
PRMPINCREASING ) Passing Relief Lane < 1 mile

® €« 5
————————————————————————————————— t
@ < @
Mainline @ e fa)
________________________________ o
__ _Menie @ ____ - > 5
| 9%
\ Passing Relief @ — -

PR MP INCREASING =y Passing Relief Lane 2 1 mile

How do | enter lane width if the project paves only part of the lane width (partial paving)? For
example, | have a project to widen an existing road, and part of the width is paved and part is existing
pavement.

If the Lane Details screen, select “Yes” for “Partial Width Paving?”, and select the partial paving width from
the list.
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How do | enter a lane or layer that is split but with different layers?

If both layers were placed as part of the same job, then the layer (to be entered in PHD) should be whichever
layer makes up a majority of the width of the lane.

If the widths are identical, a 50/50split, and part of the width is paved and part is existing pavement, then
the layer should be entered as the material placed on the job. If the widths are identical, a 50/50 split, and
both were placed as part of the job, then you may enter the option with the greatest number of layers. For
example, for the project shown in the figure below, the inside turn lane layers (in PHD) will be (milling and
two course HMA). The outside lanes’ layers (in PHD) will be HMA full depth (Subbase + Base + three HMA
layers) (i.e., do not consider the milling and two HMA layers).
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What does the Lane Type ‘Buffer Space’ mean?

It will identify the lane type as a ‘paved area where crossing or travel is prohibited by a pattern of pavement
markings.” Select this Lane Type in these situations, but make sure to evaluate the other Lane Types to
verify that this is the proper selection.

For Surface Type (pavement cross-section), do | only consider the top layer?

No. All existing layers underneath the top surface placed with the project should be considered. This applies
to each Lane and Shoulders since it is possible for Lanes and Shoulders (within the same segment) to have
different existing layers. Consider the examples below:

> If the entire asphalt pavement was replaced in this job, then the surface type is (HMA Full Depth).

» If an HMA overlay occurred in a lane with existing HMA (but without any existing concrete pavement),
then the surface type is (HMA over existing HMA).

> If an HMA overlay occurred in a lane with existing concrete pavement (regardless of directly or indirectly
below the new overlay), then the surface type is (HMA over existing Jointed Conc).

» For Micro-Surface, Chip Seal, etc., if the thickness 20.5", then this is considered as a structural layer, and
the surface type is HMA over existing HMA/Conc.

» For Micro-Surface, Chip Seal, etc., if the thickness <0.5", then this is NOT considered as a structural layer,
and the surface type is determined considering the existing layers only. Please note that even if the layer
is not considered a structural layer, it must still be entered into PHD a s a layer.

An exception for the examples above is a cross-section that has existing concrete, but is buried by a very
thick aggregate overlay, and surfaced with a new HMA pavement. This can be considered (HMA Full Depth)
since the existing concrete is deep enough that it does not significantly affect the surface HMA pavement.
A note can be added to the Segment Comments box to indicate this deep existing concrete.
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A.7 Shoulder/Curb & Gutter Details

What is included within the Shoulder width? What are the shoulder’s Total Width, Paved Width, and
Partial Width Paving?

Shoulder in PHD is measured from the edge of the vehicle travel lane to the break point of the shoulder
(end of placed aggregate material). There are three possible different Width inputs for shoulders:

1) The “Total Width” is the width of both the paved shoulder and the aggregate-based shoulder.

2) The “Paved Width” is the width of the paved shoulder (paved shoulder width in the current job).

3) The “Partial Paving Width” is the width of the paved shoulder that was paved in this job (i.e., the
remaining paved width is the existing shoulder).

The example picture shows a shoulder with 8’ paved width and 3’ Partial
Paving Width (paved in the current PHD job). The total Width is also 8’
because there is no aggregate-based shoulder.

The shoulder does not include curb & gutter, with the exception of valley curb & gutter (include valley curb
& gutter width with the ‘Paved Width’). The shoulder also includes any bike lanes and/or parking (if adjacent
to the travel lanes). For example, if a 5’ bike lane is adjacent to the 8 shoulder, then the shoulder’s width
13’ (left image below). If a 5’ bike lane is adjacent to the 11’ parking lane, then the shoulder’s width is 16’
(right image below). Please review the Lane & Shoulder Numbering guidelines for more information and
examples.

Left Shoulder Left Shoulder

Bike Lane in

PR MP INCREASING % PR MP INCREASING %

How do | enter information when there is shoulder work, but no work in the existing parking area?

Enter the shoulder’s Partial Paving Width and information of the work completed. Enter also the current
“Total Width” and “Paved Width” for the shoulder and parking area.
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How do | enter a shoulder-widening project? What if work was done to the existing shoulder before
it was widened — do we collect this information?

Enter the new “Total Width” and “Paved Width” for the shoulder and enter the “Partial Paving Width” (the
width of the paved shoulder in the widening project). Add the shoulder Layers for the work done to widen
the shoulder. In the Segment or Project Comments box, indicate the original width of the shoulder before
it was widened.

If work was done to the existing shoulder before it was widened (ex. cold milling), add a comment to the
Segment or Project Comments box to indicate what work was done to the existing shoulder before it was
widened. Also, add a comment to indicate the original width of the shoulder before it was widened.

How do | enter shoulder-only projects without deleting lanes and leaving them undefined?

For projects with shoulder-only work, the user can enter the shoulder information without creating lanes.
If the lanes were automatically created for JobNet jobs, users need to indicate no work on any lane within
the segment by selecting “No” for Work Done.

How do | enter information about intermittent curb and gutter?

If more than 5% of the total length of the curb and gutter is replaced (within a segment), then identify the
segment(s) containing this work and select “Yes” for Work Done in the Curb and Gutter area for each
segment affected. Be sure to select the left or right side as appropriate. In the Segment Comments box,

indicate that curb and gutter replacement is intermittent.

A.8 Layers & Layer Attributes

Do | have to enter layers in the existing cross-section?

No. Only layers paved/placed in the current job should be entered. Existing layers or layers paved/placed
in other jobs should not be entered with the current job. However, repairs and/or pre-overlay work on the
existing layers must be entered (diamond grinding, milling, etc.). The existing layers do, however, need to
be taken into consideration when entering the Surface Type (pavement cross-section) for the lanes and
shoulders.

Do | have to enter layers in a certain order?
Yes. In PHD, layers should be entered in order of construction/operation. Consider the following examples:

> A Crush & Shape and Asphalt Resurfacing job (with milling) should be entered in the following order
from the bottom (layer 1) to the top (layer 4): Layer 1 is “Cold Milling”, Layer 2 is “Crushed and Shaped
HMA”, Layer 3 is “HMA Leveling Course”, and Layer 4 is “HMA Top Course”.

> A Concrete Pavement Repair and Asphalt Resurfacing job (with milling after the concrete repair) should
be entered in the following order from the bottom (layer 1) to the top (layer 4): Layer 1 is “Conc. Pav.
Repair”, Layer 2 is “milling”, and Layer 3 is “HMA Top Course”.
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How do | enter Polymer Slab Stabilization projects?

This would be entered by using the ‘Pavement Jacking’ layer. Individual PHD segmentation is unnecessary
if there are several small gaps in pavement jacking. Instead, just use the limits of the stabilization/jacking
and add a note in the Segment Comments box to indicate that work is intermittent.

How do | enter Void Reducing Asphalt Membrane (VRAM) material (such as JBand) in PHD?

Within the lane in which VRAM was applied, add the (Void Reducing Asphalt Membrane) layer, and select if
this VRAM was applied on both edges of the lane (left & right) or only on one edge. No need to select any
brand (like JBand).

How do | enter high stress HMA?

The inclusion of the correct asphalt binder (PG70-22P, PG70-28P, etc.) identifies it as a high stress HMA.

In HMA layers, what is a Warm Mix? What are Shingles? How to report the use of Reclaimed asphalt?

Warm Mix Asphalt (WMA) is a general term for technologies that reduce the temperature needed to
produce and compact asphalt mixtures to construct pavements. The use of WMA in HMA pavement layer
should be identified when the mixture uses a water-injection foaming device, water-foaming additive, or
chemical additive to reduce the pavement temperature. The use of Warm Mix Asphalt can be indicated in
the HMA Job Mix Formula (JMF) (under the “REMARKS” section), or can be indicated in the “Pre-Production
Meeting Agenda” form. If used, select ‘Yes’ for “Warm Mix?” in the Pavement Attribute, then select the
Water Foaming and/or Additive used.

Recycled Asphalt Shingles (RAS) is a general term for recycling roofing shingles in new asphalt pavements.
If the HMA Job Mix Formula (JMF) indicates the use of recycled shingles, select ‘Yes’ for “Shingles used in
the mix?” in the Pavement Attribute.
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Do | have to enter scratch (wedging) courses? How do | enter those with variable thickness?

Yes. Enter/add an “HMA Wedge Course” layer. Use the average or the predominant thicknesses and insert
a Segment Comment to indicate that the thickness is variable (or within a specific range).
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If a project has an HMA layer with more than one lift, how do | enter the thickness (application rate)?

Enter the application rate per Lift. Consider the example in the Figure below. The “HMA Application
Estimate” Table indicates two lifts (2” and 1.5”) for the shoulder mix (APP2). The user should enter each lift
as a separate layer in the shoulder: a 2” layer (5SEML HMA Level Course with a 220 Application Rate) followed
by a 1.5” layer (5EML HMA Top Course with a 165 Application Rate).
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How do | specify that a project used intermittent asphalt resurfacing repair (HMA skip patching)?
Should I split the segment at each patch (segmentation)?

Enter/add an “HMA Skip Patching” layer to indicate any intermittent asphalt resurfacing repair (HMA
patches). Do not split the segment at each patch. When the “HMA Skip Patching” layer is used, PHD will not
consider this a continuous HMA layer in the specified segment (PR# and milepoints), so no segmentation is
required.

How do | specify that a project used crumb rubber in the binder?

This can be indicated in the Segment Comments or Project Comments boxes.

How do | enter paving that extends over the gutter pan of the curb?

Record this information by adding a note to the Segment Comments or the Project Comments boxes.

Why don’t | see a certified supplier, an emulsion type, a silane material type, etc., in the drop-down
choices? Can | request deleting a supplier/product that no longer exists?

Contact the PHD Administrator to see if the desired measurement/layer/attribute can be added.

Old suppliers/products that no longer exist will not be deleted from the drop-down choices in PHD. These
suppliers/products may still be in use for old projects that still need to be added, or edited.

For the concrete layer (PCC pavement layer), why don’t | see the specific Cement Content (#/cyd) in
the drop-down choices? For example, 325 #/cyd.

Certain values are determined (or pre-calculated) based on MDOT specifications, past projects, or
experience. For example, cement content is based on the unit bag weight which is 94 Ibs. One common
Cement Content value is 329 #/cyd (3.5 bags x 94 Ibs), so 325 is not available. The users can use 329 #/cyd
(in lieu of the actual 325 #/cyd used in the concrete JMF) because it is close enough to the actual value.
However, if the user needs to enter a value in which no close option is available in the drop-down choices,
please contact the PHD Administrator to see if the desired value can be added to the drop-down choices.
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How do | enter Crack Sealing and/or Crack Filling, and how are these different? How do | enter work
done on longitudinal and/or transverse joints/cracks?

The “HMA Crack Treatment” layer in PHD represents crack sealing work (with or without crack filling) for
asphalt pavements (used for “working” cracks). Crack sealing is attained by the saw/rout and seal method.
The required inputs in PHD are the Cut and Seal Method, Crack Seal Product Name, and Crack Seal
Manufacturer. If Overband is also used (crack filling), then the Overband Crack Fill Product is also required.

The “Overband CrackFill” layer in PHD indicates work that consists of cleaning the crack in the HMA
pavement surface and placing the specified materials into and above the crack to substantially reduce
infiltration of water and to reinforce the adjacent pavement (used for “non-working” cracks). This could also
be a pre-treatment for Chip Seals, Micro Surfacing, and Hot-Mix overlays. The required input in PHD is the
Overband Crack Fill Product.

In projects with crack sealing and/or crack filling, if all lanes and/or longitudinal joints are being worked on,
then the job can be created as a Simplified CPM project. Simply add the appropriate layer and add Project
or Segment Comment(s) to describe the work in more detail (to identify transverse and/or longitudinal
work).

However, if work isn’t on/between all lanes, then create the job as a standard PHD job and use the following
methods to add “HMA Crack Treatment” or “Overband CrackFill” layers:

> For the longitudinal joint, the user should add the lowest lane number adjacent to the longitudinal joint
and add information to that lane.

> For transverse joints, add the lanes that the transverse joints go through and add information to all
associated lanes.

What is “Crack Relief Interlayer/DRM”? is it the same as “Asphalt Stabilized Crack Relief Layer
(ASCRL)”?

The “Crack Relief Interlayer”, sometimes called DRM (Distress Resistant Membrane), is a layer consisting of
sealant, emulsion, and aggregate used to prevent reflective cracks in asphalt pavements. It is a one pass
system in which the sealant, emulsion, and aggregate are applied in succession. The sealant is spread into a
thin film using a spreader box to fill the crack area.
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Asphalt Stabilized Crack Relief Layer (ASCRL) is an HMA mixture primarily used as a base course in a multi-
course overlay of concrete pavement to delay reflective cracking. It typically contains less asphalt cement

and aggregate fines than a standard HMA base
.
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ASCRL as the mix type.
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How do | enter Cape Seal Treatment?

A Cape Seal is a combination of a chip seal followed by a micro-surface, which can be used to effectively
treat pavements with a higher level of distress, including higher levels of cracking and raveling. To enter this
into PHD, add a Chip Seal layer and then add a Micro-Surface layer (showing the Micro-Surface layer on
top).

Can there be a drop-down for bond coat type?

The inclusion of bond coat type was determined to be a nonessential entry item.

How do | enter Detail 7s and 8s? How do these treatments differ between HMA and Concrete layers?

Detail 7 (surface repair for joints or cracks) and Detail 8 (full-depth Detail 7
repair for joints or cracks) are common treatments for joints and cracks
of concrete pavements. In PHD, add the layer “Conc Pavt Repairs (Det
7 & 8)”, and answer “Yes” for each type used on the project and enter Detail 7
the mix type used.
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How do | enter crushed & shaped HMA? What thickness should | enter?

Add the layer “Crushed and Shaped HMA”. For thickness, use the thickness of crushed HMA plus the
thickness of existing aggregate below to be mixed with this layer (typically around 1 inch). If the existing
HMA is cold milled before crushing, then subtract this milled thickness from the existing HMA thickness to
be used for the “Crushed and Shaped HMA” thickness.

If the thickness of the existing HMA is variable, use the predominant or average thickness. However, if the
HMA thickness is variable in the job, but consistent within certain segments, then the segment should be

split (segmentation) so that each of the distinct thicknesses is entered for the “Crushed and Shaped HMA”
layer.
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Do | have to enter HMA milling? How do | enter two milling layers?

Yes. HMA milling work is required in PHD. Add the “Cold Milling” layer, and select the milling depth, milling

texture, and milling type.
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What qualifies as an aggregate and should be added to the layer(s)?

Why don’t | see the aggregate names from the HMA Job Mix Formula (JMF) in the list of aggregate

types?
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How do | enter borrow materials as an aggregate?

A “borrow pit” is a hole, pit, or excavation that has been dug
for the purpose of removing gravel, clay, soil or sand to be
used in a construction project.

In PHD, users can select the aggregate class from the drop-
down list (or select “Other” and enter a non-standard
aggregate name). Borrow materials do not have a Pit No.
Therefore, to enter the borrow materials source, enter the
county number for the county where the material originated
in the first box. In the second box, enter 000. For the
example on the right (CLIIAA material from Osceola County),
use 67-000.
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How do | enter recycled materials as an aggregate?

To enter recycled materials (including crushed concrete), locate the associated county and pit number. This
information can be located per acceptance testing of the recycled material.

Note that this material, unlike a borrow material, is tested and identified with a pit number because the
recycled material needs to be approved for use.

How do | enter Dock aggregate? What is the DOCK aggregate source/pit number?

Aggregates identified as “Dock” are those that were shipped into and stored at a dock. Dock aggregate
comes from the prequalified aggregate list, so it does have an actual name and source/pit number. The
aggregate tickets should provide the actual name and number information.

Why can’t aggregate information be optional rather than required? What if aggregate information is
unknown?

PHD Sponsors and MDOT personnel who use PHD data have previously supported requiring aggregate
information. This information has been used to compare pavement condition data for segments with
different aggregates/sources. If aggregate information is unknown or not attainable, “Unknown” is an
option for the aggregate class. Users still need to enter the Pit No. (entering in the first box the county
number for the county where the material originated and entering 000 in the second box). For example, use
67-000 (material from Osceola County — county code is 67).

Why don’t | see some layers that used to be available in PHD, such as Cobblestone, Corduroy, and
Slurry Seal?

Since some layers were not constructed (and thus, not being used in PHD) in the last 10 years, those layers
have been archived. If one or more of these layers are needed (in PHD), please contact PHD Administrators
to add the layer(s) to the list of available layers in PHD.
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